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Patents
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Cy5.5 and Cy7: US 5,268,486; 5,486,616; 5,569,587; 5,569,766; and 5,627,027
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FCC Information

WARNING: Changes or modifications to this unit not expressly approved by the party responsible for compliance 
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NOTICE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference 
when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful 
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This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Réglement sur the matériel brouilleur du 
Canada.
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About This Guide

The BD LSR II User’s Guide describes the procedures necessary to operate and 
maintain your BD™ LSR II flow cytometer. Because many instrument functions 
are controlled by BD FACSDiva™ software, this guide also contains information 
about software features required for basic instrument setup and operation. 

For an annotated list of additional documentation for your BD LSR II flow 
cytometer, see BD LSR II Documentation on page xii.

Conventions

The following tables list conventions used throughout this guide. Table 1 lists the 
symbols that are used to alert you to a potential hazard. Text and keyboard 
conventions are shown in Table 2. 

Table 1  Hazard symbolsa

a. Although these symbols appear in color on the instrument, they are in black and white throughout this user’s 
guide; their meaning remains unchanged.

Symbol Meaning

Caution: hazard or unsafe practice that could result in material damage, data 
loss, minor or severe injury, or death

Electrical danger

Laser radiation

Biological risk
xi
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BD LSR II Documentation

BD LSR II Online Help

The online help installed with your BD FACSDiva software contains the same 
text as that in the documents listed below, enhanced with features like full text 
search and related topic links. Access BD LSR II online help from the Help menu 
of BD FACSDiva software. 

BD LSR II online help topics are compiled from the following sources:

• BD FACSDiva Software Reference Manual

• BD LSR II User’s Guide

• BD High Throughput Sampler User’s Guide

Table 2  Text and keyboard conventions

Convention Use

Tip     Highlights features or hints that can save time and prevent 
difficulties

NOTICE     Describes important features or instructions 

Italics Italics are used to highlight book titles and new or unfamiliar 
terms on their first appearance in the text. 

> The arrow indicates a menu choice. For example, “choose 
File > Print” means to choose Print from the File menu.

Ctrl-X When used with key names, a dash means to press two keys 
simultaneously. For example, Ctrl-P means to hold down the 
Control key while pressing the letter p. 
xii BD LSR II User’s Guide
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Printed Documentation

A printed copy of the following documents is distributed with the BD LSR II flow 
cytometer:

• BD LSR II User’s Guide describes procedures necessary to operate and 
maintain your BD LSR II flow cytometer. Because many instrument 
functions are controlled by BD FACSDiva software, this guide also 
contains information about software features required for basic instrument 
setup and operation. 

• BD LSR II Safety and Limitations booklet discusses the safety features of 
the BD LSR II flow cytometer. It lists precautions for the cytometer’s laser, 
electrical, and biological hazards, and states limitations of use.

• BD LSR II Facility Requirement Guide contains specifications for:

- instrument weight and size

- temperature and other environmental requirements

- electrical requirements

• Getting Started with BD FACSDiva Software contains tutorial exercises 
that familiarize you with key software procedures and concepts.

• A printed copy of the BD High Throughput Sampler User’s Guide is 
distributed with the BD™ High Throughput Sampler (HTS) option. This 
document describes how to set up and operate the HTS. It also contains a 
description of BD FACSDiva software features specific to the HTS.
About This Guide xiii
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Electronic Documentation

PDF versions of the following documents can be found on the BD FACSDiva 
software installation disk or on your computer hard drive:

• The BD FACSDiva Software Reference Manual includes instructions or 
descriptions for installation and setup, workspace components, acquisition 
controls, analysis tools, and data management. It can be accessed from the 
BD FACSDiva Software Help menu (Help > Software Manual), or by 
double-clicking the shortcut on the desktop. In addition, a printed copy can 
be requested from BD Biosciences.

• Getting Started with BD FACSDiva Software can be accessed from Start > 
Programs > BD FACSDiva Software, or by double-clicking the shortcut on 
the desktop.

• The BD LSR II User’s Guide and BD High Throughput Sampler User’s 
Guide PDFs can be found on the BD FACSDiva software installation disk 
in the Instrument User Guides folder.

• The BD FACSDiva Option White Paper can be downloaded from the 
BD Biosciences website. This white paper contains an in-depth discussion 
of the digital electronics used in the BD LSR II cytometer. 
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Technical Assistance

For technical questions or assistance in solving a problem:

• Read sections of the documentation specific to the operation you are 
performing (see BD LSR II Documentation on page xii). 

• See Chapter 7, Troubleshooting.

If additional assistance is required, contact your local BD Biosciences technical 
support representative or supplier. 

When contacting BD Biosciences, have the following information available:

• product name, part number, and serial number

• version of BD FACSDiva software you are using

• any error messages

• details of recent system performance

For instrument support from within the US, call (877) 232-8995.

For support from within Canada, call (888) 259-0187.

Customers outside the US and Canada, contact your local BD representative or 
distributor.
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Safety and Limitations

The BD LSR II flow cytometer and its accessories are equipped with safety 
features for your protection. Operate only as directed in the BD LSR II User’s 
Guide and the BD LSR II Safety and Limitations booklet. Do not perform 
instrument maintenance or service except as specifically stated. Keep this safety 
information available for reference.

Laser Safety

Lasers or laser systems emit intense, coherent electromagnetic radiation that has 
the potential of causing irreparable damage to human skin and eyes. The main 
hazard of laser radiation is direct or indirect exposure of the eye to thermal 
radiation from the visible and near-infrared spectral regions (325–1400 nm). 
Direct eye contact can cause corneal burns, retinal burns, or both, and possible 
blindness.

There are other potentially serious hazards in other spectral regions. Excessive 
ultraviolet exposure produces an intolerance to light (photophobia) accompanied 
by redness, a tearing discharge from the mucous membrane lining the inner 
surface of the eyelid (conjunctiva), shedding of the corneal cell layer surface 
(exfoliation), and stromal haze. These symptoms are associated with 
photokeratitis, otherwise known as snow blindness or welder’s flash, which 
results from radiant energy–induced damage to the outer epidermal cell layer of 
the cornea. These effects can be the result of laser exposure lasting only a fraction 
of a second.
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Laser Product Classification

Laser hazard levels depend on laser energy content and the wavelengths used. 
Therefore, it is impossible to apply common safety measures to all lasers. A 
numbered system is used to categorize lasers according to different hazard levels. 
The higher the classification number, the greater the potential hazard. The 
BD LSR II flow cytometer is a Class I (1) laser product per 21 CFR Subchapter J 
and IEC/EN 60825-1:1994 + A1:2003 + A2:2001. The lasers and the laser 
energy are fully contained within the instrument structure and call for no special 
work area safety requirements except during service procedures. These 
procedures are to be carried out only by BD Biosciences service personnel.

Precautions for Safe Operation   

Modification or removal of the optics covers or laser shielding could result 
in exposure to hazardous laser radiation. To prevent irreparable damage to 
human skin and eyes, do not remove the optics covers or laser shielding, 
adjust controls, or attempt to service the instrument any place where laser 
warning labels are attached (see Symbols and Labels on page xxi). 

Use of controls or adjustments or performance of procedures other than 
those specified in the user’s guide may result in hazardous radiation 
exposure.

Keep all instrument doors closed during instrument operation. When 
operated under these conditions, the instrument poses no danger of 
exposure to hazardous laser radiation.
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Electrical Safety

• Turn off the power switch and unplug the power cord before servicing the 
instrument, unless otherwise noted.

• Connect the equipment only to an approved power source. Do not use 
extension cords. Have an electrician immediately replace any damaged 
cords, plugs, or cables. Refer to the BD LSR II Facilities Requirement 
Guide for specific information.

• Do not remove the grounding prong from the power plug. Have a qualified 
electrician replace any ungrounded receptacles with properly grounded 
receptacles in accordance with the local electrical code.

• For installation outside the US, use a power transformer or conditioner to 
convert the local power source to meet the BD LSR II power requirements 
(120 V ±10%, 50/60 Hz). Contact your local BD office for further 
information.

Lethal electrical hazards can be present in all lasers, particularly in laser 
power supplies. Every portion of the electrical system, including the printed 
circuit boards, should be considered to be at a dangerous voltage level. 
Avoid potential shock by following these guidelines.
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Biological Safety

• Handle all biological specimens and materials as if capable of transmitting 
infection. Dispose of waste using proper precautions and in accordance 
with local regulations. Never pipette by mouth. Wear suitable protective 
clothing, eyewear, and gloves.

• Expose waste container contents to bleach (10% of total volume) for 30 
minutes before disposal. Dispose of waste in accordance with local 
regulations. Use proper precaution and wear suitable protective clothing, 
eyewear, and gloves.

• Prevent waste overflow by emptying the waste container frequently or 
whenever the waste management system alarms.

For information on laboratory safety, refer to the following guidelines. NCCLS 
documents can be ordered online at www.nccls.org.

• Schmid I, Nicholson JKA, Giorgi JV, et al. Biosafety guidelines for sorting 
of unfixed cells. Cytometry. 1997;28:99-117.

• Protection of Laboratory Workers from Instrument Biohazards and 
Infectious Disease Transmitted by Blood, Body Fluids, and Tissue; 
Approved Guideline. Wayne, PA: National Committee for Clinical 
Laboratory Standards, 1997. NCCLS document M29-A. 

• Procedures for the Handling and Processing of Blood Specimens; Approved 
Guideline. Wayne, PA: National Committee for Clinical Laboratory 
Standards; 1990. NCCLS document H18-A.

All biological specimens and materials coming into contact with them are 
considered biohazardous. Avoid exposure to biohazardous material by 
following these guidelines.
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General Safety

Symbols and Labels

The following symbols, warnings, or precaution labels appear on the
BD LSR II flow cytometer or the waste and fluid tanks.

The instrument handles are for BD Biosciences authorized personnel only. 
Do not access them or attempt to lift the instrument with them, or you 
could injure yourself.

To avoid burns, do not touch the fan guards on the back of the instrument. 
The fan guards could be hot during and after instrument operation.

Movement of mechanical parts within the instrument can pinch or injure 
your hands or fingers. To prevent injury by moving parts, keep your hands 
and clothing away from the instrument during operation.

Symbol Meaning Location(s)

� Dangerous voltage Rear instrument panel near power 
receptacle

� Laser radiation hazard Near all removable covers and any 
place where the laser beam can 
emerge from the instrument

� Caution! Consult accompanying 
documents.

Near the instrument handles
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Label Meaning Location(s)

Caution

Hot surface

Rear instrument panel 
adjacent to exhaust fans

Caution

Turn power off before 
service.

• Rear instrument panel 
adjacent to power 
receptacle

• Near internal power 
shield

Caution

High voltage

Rear instrument panel 
adjacent to power 
receptacle

Biological risk: Waste

Risk of exposure to 
biologically 
transmissable disease

System waste tank

Danger

Visible and/or 
invisible laser 
radiation when 
removed. Avoid eye 
or skin exposure to 
direct or scattered 
radiation.

Near all removable 
covers and any place 
where the laser beam can 
emerge from the 
instrument

(B) Sheath Near BD FACSFlow™ 
solution (sheath) port

334972

CAUTION: 
Hot Surface

ATTENTION:
Surface Chaude

334974

!
CAUTION: 
Turn power off
before service.

ATTENTION:
Mettre hors tension
avant toute 
intervention.

334973

CAUTION: 
High Voltage

ATTENTION:
Haute tension

Waste (A)
336325 Rev. A
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Limitations

For Research Use Only. Not for use in diagnostic or therapeutic procedures.

BD Biosciences delivers software and workstations that are intended for running 
the instruments supplied by BD Biosciences. It is the responsibility of the buyer/
user to ensure that all added electronic files including software and transport 
media are virus free. If the workstation is used for Internet access or purposes 
other than those specified by BD Biosciences, it is the buyer/user’s responsibility 
to install and maintain up-to-date virus protection software. BD Biosciences does 
not make any warranty with respect to the workstation remaining virus free after 
installation. BD Biosciences is not liable for any claims related to or resulting 
from buyer/user's failure to install and maintain virus protection.
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1

Introduction

The following topics are covered in this chapter:

• Overview on page 26

• Fluidics on page 28

• Optics on page 32

• BD LSR II Workstation on page 36
25
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Overview

The BD LSR II is an air-cooled multi-laser benchtop flow cytometer with the 
ability to acquire parameters for a large number of colors. It uses fixed-alignment 
lasers that transmit light reflected by mirrors through a flow cell to user-
configurable octagon and trigon detector arrays. These detectors collect and 
translate fluorescence signals into electronic signals. Instrument electronics 
convert these signals into digital data.

Components

Figure 1-1  BD LSR II flow cytometer

Power Switch

The power switch is located on the lower-right side of the BD LSR II instrument 
as shown in Figure 1-1.

control panel
SIP

left cover

power switch

fluidics
interconnec

right coverside door 

instrument handle
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Control Panel

The control panel contains fluidics controls (Figure 1-2). For a description of the 
controls, see:

• Sample Flow Rate Control on page 28

• Fluid Control on page 28

Figure 1-2  Control panel

Handles

The instrument handles (Figure 1-1 on page 26) are for BD Biosciences 
authorized personnel only. Do not access them or attempt to lift the 
instrument with them, or you could injure yourself.

LO MED HI

RUN STNDBY PRIME

sample flow rate 
fluid control buttons

SAMPLE
FINE ADJ

control buttons
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Fluidics

The purpose of the fluidics system is to carry the sample out of the sample tube 
and into the sensing region of the flow cell. Cells are carried in the sample core 
stream in single file and measured individually.

Sample Flow Rate Control

Three flow rate control buttons—LO, MED, and HI—set the sample flow rate 
through the flow cell. The SAMPLE FINE ADJ knob allows you to adjust the 
rate to intermediate levels.

When the SAMPLE FINE ADJ knob is at its midpoint, the sample flow rates at 
the LO, MED, and HI settings are approximately 12, 35, and 60 µL/min of 
sample, respectively. The knob turns five full revolutions in either direction from 
its midpoint, providing sample flow rates from 0.5–2X the midpoint value. For 
example, if the LO button is pressed, the knob will give flow rates from 
approximately 6–24 µL/min.

Fluid Control

Three fluid control buttons—RUN, STNDBY, and PRIME—set the instrument 
mode (Figure 1-2 on page 27).

• RUN pressurizes the sample tube to transport the sample through the 
sample injection tube and into the flow cell.

The RUN button is green when the sample tube is on and the support arm 
is centered. When the tube support arm is moved left or right to remove a 
sample tube, the instrument switches to an automatic standby status to 
conserve sheath fluid—the RUN button changes to orange.

• STNDBY (standby) stops fluid flow to conserve sheath fluid.

When you leave the instrument for more than a few minutes, place a tube 
containing 1 mL of deionized (DI) water on the sample injection port (SIP) 
and press STNDBY.
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• PRIME prepares the fluidics system by draining and filling the flow cell 
with sheath fluid.

The fluid flow initially stops and pressure is reversed to force fluid out of 
the flow cell and into the waste container. After a preset time, the flow cell 
fills with sheath fluid at a controlled rate to prevent bubble formation or 
entrapment. At completion, the instrument switches to STNDBY mode.

Sample Injection Port

The sample injection port (SIP) is where the sample tube is installed. The SIP 
includes the sample injection tube and the tube support arm. Samples are 
introduced through a stainless steel injection tube equipped with an outer droplet 
containment sleeve. The sleeve works in conjunction with a vacuum pump to 
eliminate droplet formation of sheath fluid as it backflushes from the sample 
injection tube.

Figure 1-3  Sample injection port (SIP)

tube stop

Bal seal

outer sleeve

tube support arm

sample injection tube
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• Sample injection tube—stainless steel tube that carries sample from the 
sample tube to the flow cell. This tube is covered with an outer sleeve that 
serves as part of the droplet containment system.

• Tube support arm—arm that supports the sample tube and activates the 
droplet containment system vacuum. The vacuum is on when the arm is 
positioned to the side and off when the arm is centered.

Droplet Containment System

The droplet containment system prevents sheath fluid from dripping from the SIP 
and provides biohazard protection.

When no sample tube is installed on the SIP, sheath fluid backflushes through the 
sample injection tube. This backflush helps prevent carryover of cells between 
samples. The droplet containment system vacuum is activated when the sample 
tube is removed and the tube support arm is moved to the side. Sheath fluid is 
aspirated as it backflushes the sample injection tube.

If a sample tube is left on the SIP with the tube support arm to the side (vacuum 
on), sample will be aspirated into the waste container.
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Sheath and Waste Containers

The sheath and waste containers are outside the instrument and can be 
positioned on the floor.

Sheath Container

The sheath container has a capacity of 8 L. Sheath fluid is filtered through an in-
line, interchangeable filter that prevents small particles from entering the sheath 
fluid lines.

Before opening the sheath container:

1 Put the instrument in STNDBY mode.

2 Disconnect the air line (green).

3 Depressurize the sheath container by lifting its vent cap.

Waste Container

The waste container has a capacity of 10 L. An alarm sounds when the container 
becomes full.

To avoid leakage of biohazardous waste, put the instrument in STNDBY 
mode before disconnecting the waste container.

The waste container contents might be biohazardous. Treat contents with 
bleach (10% of total volume). Dispose of waste with proper precautions in 
accordance with local regulations. Wear suitable protective clothing, 
eyewear, and gloves.

The waste container is heavy when full. When emptying it, use good body 
mechanics to prevent injury.
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Optics

Figure 1-4 shows the optical bench components of the BD LSR II instrument. 

Figure 1-4  Optical bench components (engineering model)

photomultiplier tubes (PMTs) Devices that convert optical signals into 
electrical signals (see Detectors on page 35)

octagon Array of PMTs and filters that can detect up 
to eight signals (Figure 1-5 on page 35)

trigon Array of PMTs and filters that can detect up 
to three signals (Figure 1-6 on page 36)

lasers: blue 488 nm, red 633 nm, UV 
355 nm, and violet 405 nm

See Lasers on page 33.

optics cover Shielding that houses the flow cell, forward 
scatter (FSC) assembly (see Detectors on 
page 35), and the excitation optics

photomultiplier tube (PMT)

trigon

octagon

blue 488-nm laser (standard)

red 633-nm laser 

UV 355-nm laser

violet 405-nm laser

steering optics

(optional)

(optional)

(optional)

photomultiplier tube (PMT)
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Lasers

The BD LSR II flow cytometer has a fixed-alignment 488-nm laser with the 
option of additional fixed-alignment lasers.

The primary blue 488-nm laser (Coherent Sapphire) generates forward scatter 
(FSC) and side scatter (SSC) signals and four fluorescence signals.

• The optional red 633-nm laser (JDS Uniphase 1344P) generates two 
fluorescence signals.

• The optional violet 405-nm laser (Coherent Radius 405) generates two 
fluorescence signals.

• The optional UV 355-nm laser (Lightwave Xcyte) generates two 
fluorescence signals.

Table 1-1  BD LSR II flow cytometer laser options

Laser Type
Wavelength 

(Color)
Power 
(mW)

Warm-Up 
Time 
(min)

Standard Coherent Sapphire™ solid state 488 nm (blue) 20 30

Optional JDS Uniphase 1344P helium-
neon 
(HeNe) gas

633 nm (red) 17 20

Coherent Radius™ 405 solid state 405 nm (violet) 25 15

Lightwave Xcyte™ solid state 355 nm (UV) 20 30
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Filters

Optical filters attenuate light or help direct it to the appropriate detectors. The 
BD LSR II instrument uses dichroic filters. Dichroic filters transmit light of a 
specific wavelength, while reflecting other wavelengths. The name and spectral 
characteristics of each filter appear on its holder.

There are three types of dichroic filters:

• Shortpass (SP) filters transmit wavelengths that are shorter than the 
specified value.

• Longpass (LP) filters transmit wavelengths that are longer than the 
specified value.

• Bandpass (BP) filters pass a narrow spectral band of light by combining the 
characteristics of shortpass filters, longpass filters, and absorbing layers. 
Discriminating filters (DF) and ALPHA™ filters (AF) are types of bandpass 
filters.

When dichroic filters are used as steering optics to direct different color light 
signals to different detectors, they are called dichroic mirrors or beam splitters.

• Shortpass dichroic mirrors transmit shorter wavelengths of light to one 
detector while reflecting longer wavelengths to a different detector.

• Longpass dichroic mirrors transmit longer wavelengths to one detector 
while reflecting shorter wavelengths to a different detector.

The BD LSR II instrument octagon and trigon detector arrays use dichroic 
longpass mirrors on their inner rings, and bandpass filters on their outer rings. 
However, you can customize the arrays with other types of filters and mirrors. 

In Figure 1-5 on page 35, the inner ring is colored gray, and the outer is blue. 
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Figure 1-5  Dichroic filter types in octagon array

The steering optics and filters mounted on the BD LSR II instrument are listed in 
Table E-1 on page 154.

See Optical Filters on page 127 for a more detailed explanation of how filters 
work in the BD LSR II flow cytometer.

Detectors

Light signals are generated as particles pass through the laser beam in a fluid 
stream. When these optical signals reach a detector, electrical pulses are created 
that are then processed by the electronics system.

There are two types of signal detectors in the BD LSR II flow cytometer: the 
photodiode and the photomultiplier tubes, or PMTs (Figure 1-6 on page 36). A 
photodiode is less sensitive to light signals than the PMTs. Therefore, a 
photodiode is used to detect the stronger forward scatter signal. PMTs are used 
to detect the weaker signals generated by side scatter and all fluorescence 
channels. These signals are amplified by applying a voltage to the PMTs. As the 
voltage is increased, the detector sensitivity increases, resulting in increased 

longpass dichroic mirrors

bandpass filters
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signal. As the voltage is decreased, the detector sensitivity decreases, resulting in 
decreased signal. Detector voltages are adjusted in BD FACSDiva software.

Figure 1-6  PMT-type detectors in trigon array

The default locations of specific detectors and filters within BD LSR II 
instrument octagon and trigon arrays are shown in Table E-1 on page 154.

BD LSR II Workstation

Acquisition, analysis, and most BD LSR II instrument functions are controlled by 
the BD LSR II workstation. It includes a PC, one or two monitors, and a printer. 

Your workstation is equipped with the following:

• a BD Biosciences–validated Microsoft® Windows® operating system

• BD FACSDiva software for data acquisition and analysis 

• software documentation including an online help system

See BD LSR II Documentation on page xii for more information.

PMT

PMT
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2

Instrument Setup

• Starting the Cytometer and Computer on page 38

• Setting Up the Optical Filters and Mirrors on page 39

• Preparing Sheath and Waste Containers on page 44

• Preparing the Fluidics on page 47

• Quality Control on page 49
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Starting the Cytometer and Computer

1 Turn on the power to the flow cytometer.

Allow 60 minutes for lasers to warm up and stabilize.

2 Start up the BD LSR II workstation and log in to Windows.

Tip     You can turn on the power to the flow cytometer and the workstation 
in any order.

3 Launch BD FACSDiva software by double-clicking the shortcut on the 
desktop, and log in to the software.

For details about user accounts in BD FACSDiva software, refer to the 
BD FACSDiva Software Reference Manual.

4 Check the Instrument window in BD FACSDiva software to ensure the 
cytometer is connected to the workstation.

The cytometer connects automatically. While connecting, the message 
Instrument Connecting is displayed in the window footer. When 
connection completes, the message changes to Instrument Connected 
(Figure 2-1 on page 39).

If the message Instrument Disconnected appears, refer to Electronics 
Troubleshooting in the BD FACSDiva Software Reference Manual.

Failure to warm up and stabilize the lasers could affect sample data.
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Figure 2-1  Instrument Connected message

Setting Up the Optical Filters and Mirrors

Before you run samples, set up the optical filters. The following figure shows the 
location of the detector arrays (beneath the instrument covers of the BD LSR II 
flow cytometer). Each detector array is labeled with its laser source.

blue octagon

violet trigon UV trigon

red trigon 
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Filter and Mirror Configurations

Each PMT (except the last PMT in every 
detector array) has two slots in front of it. 

• The slot closest to the PMT holds a 
bandpass filter holder.

• The slot furthest from the PMT 
holds a longpass dichroic mirror 
holder.

The last PMT in every detector array (PMT H in the octagon, and PMT C in all 
trigons) does not have a mirror slot.

Optical Holders, Filters, and Mirrors

Optical holders house filters and mirrors. Your instrument includes several blank 
(empty) optical holders.

Figure 2-2  Blank optical holders, filters, and mirrors

Tip     To ensure data integrity, do not leave any slots unfilled in a detector array 
when you are using the associated laser. Always use a blank optical holder.

filter slot

mirror slot

PMT A

bandpass filter

(filter slot)
blank optical holder

empty

longpass dichroic mirror

blank optical holder
(mirror slot)

empty
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Default Configurations

Each BD LSR II instrument has a default filter and mirror configuration. The 
standard default configuration is specified for an instrument with an octagon 
detector array for the 488-nm blue laser, and trigon detector arrays for any 
optional lasers. See Appendix E for a detailed description of the standard default 
configuration, also called the 4-Blue 2-Violet 2-UV 2-Red default configuration.

Additional special-order configurations are specified for instruments with non-
standard detector arrays. For example, there is a 6-Blue 6-Violet 2-UV 3-Red 
default configuration for an instrument that has octagon detector arrays for both 
the 488-nm blue laser and the 405-nm violet laser, and trigon detector arrays for 
both the UV laser and the 633-nm red laser. Detailed descriptions of the 
additional special-order configurations are in Appendix F.

BD FACSDiva Instrument Configuration

When you acquire data using BD FACSDiva software, you specify an instrument 
configuration. The instrument configuration defines which fluorochrome or 
scatter parameter is measured at each instrument detector.

BD FACSDiva software provides a default instrument configuration based on 
your BD LSR II. Use the Instrument Configuration dialog to modify, delete, and 
create new instrument configurations. (Refer to the Instrument and Acquisition 
Controls chapter of the BD FACSDiva Software Reference Manual for details.) 

BD LSR II Configuration Upgrade

If you upgrade your BD LSR II cytometer with additional lasers or special order 
detector arrays, you will need to run the ICA software to update the 
BD FACSDiva database for your instrument. Instructions for installing and using 
the ICA software are in Appendix F.
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Changing Optical Filters or Mirrors

1 Lift the appropriate instrument cover.

• The octagon array is located under the right instrument cover.

• The three trigon arrays are located under the left instrument cover.

Tip     To open the left instrument cover, you must first open the right cover 
and the side door.

2 Remove the appropriate filter holder or mirror holder.

3 Replace it with the new filter holder or mirror holder.

Tip     The filters and mirrors fit easily into the optical holders in only one 
way.

4 Close the instrument cover(s).

Custom Configurations 

See Custom Configurations in Appendix E for specifications of some common 
custom filter and mirror configurations. The custom filters and mirrors used in 
these configurations are included with your spares kit.

Follow the precautions outlined in Laser Safety on page xvii while changing 
optical filters or mirrors.
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Filter and Mirror Specifications

Table 2-1  Longpass dichroic mirrors in octagon or trigon

Specification Measurement

diameter 0.625 in. +0.000, –0.005

minimum clear aperture 0.562 in.

incident angle 11.25°

thickness 0.125 in ±0.005 in.

Table 2-2  Bandpass filters in octagon or trigon

Specification Measurement

diameter 1.00 in. ±0.010 in.

minimum clear aperture 0.85 in.

incident angle 0°

thickness 0.12–0.35 in.
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Preparing Sheath and Waste Containers

Tip     Check the fluid levels in the sheath and waste containers every time you use 
the instrument. This ensures that you will not run out of sheath fluid during an 
experiment and that the waste container will not become too full.

Preparing the Sheath Container

Figure 2-3  Sheath container

air line

filter assembly

sheath tank

cytometer 
line 

clamp
knob

fill point

vent valve
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1 Make sure that the flow cytometer is in STNDBY mode.

2 Disconnect the air line (green) from the sheath container (Figure 2-3 on 
page 44).

3 Depressurize the sheath container by pulling up on its vent valve.

4 Remove the sheath container lid.

Unscrew the clamp knob and lift.

5 Add 6 L of sheath fluid, such as BD FACSFlow™ solution, to the sheath 
container.

NOTICE     Do not fill the sheath tank to its maximum capacity (8 L). When 
a full tank is pressurized, erratic instrument performance can result.

Tip     For calcium-flux experiments, use a sheath fluid that does not contain 
preservatives. For example, use 1X phosphate-buffered saline (PBS).

6 Close the sheath container lid.

7 Reconnect the air line (green).

8 Make sure the lid is tightly sealed with the gasket in place, the clamp knob 
is finger-tight, and that the cytometer fluid line (blue) is not kinked.

Tip     Inspect the sheath container periodically, as sheath fluid can cause 
corrosion.
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Preparing the Waste Container

Figure 2-4  Waste container

1 Disconnect the orange waste tubing and the black level sensor line from the 
waste container.

Keep the lid on the waste container until you are ready to empty it.

2 Empty the waste container.

All biological specimens and materials coming into contact with them are 
considered biohazardous. Handle as if capable of transmitting infection. 
Dispose of waste using proper precautions and in accordance with local 
regulations. Never pipette by mouth. Wear suitable protective clothing, 
eyewear, and gloves.

The waste container contents might be biohazardous. Treat contents with 
bleach (10% of total volume). Dispose of waste using proper precautions 
and in accordance with local regulations. Wear suitable protective clothing, 
eyewear, and gloves.

waste tubing
(from cytometer)

level sensor line

bracket
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3 Add approximately 1 L of bleach to the waste container and close it.

4 Reconnect the orange waste tubing and make sure it is not kinked.

5 Reconnect the level sensor line.

Preparing the Fluidics

Next, make sure the fluidics system is ready. This section covers the following 
preparations:

• Removing Air Bubbles (below)

• Priming the Fluidics on page 49

Removing Air Bubbles

Trapped bubbles can occasionally dislodge and pass through the flow cell, 
resulting in inaccurate data.

NOTICE     Do not vigorously shake, bend, or rattle the sheath filter or you might 
damage it.

1 Check the sheath filter for trapped air bubbles.

2 If bubbles are visible, gently tap the filter body with your fingers to 
dislodge the bubbles and force them to the top.
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3 Pinch the vent line closed.

Figure 2-5  Sheath filter

4 Loosen the sheath filter vent cap to bleed off any air in the filter; collect the 
excess fluid in a container.

5 Replace the vent cap.

6 Check the fluid lines for air bubbles.

7 Open the roller clamp on the blue cytometer fluid line (if necessary) to 
bleed off any air in the line.

8 Close the roller clamp.

vent cap

vent line

cytometer fluid line 
(roller clamp not visible)
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Priming the Fluidics

Sometimes, air bubbles and debris are stuck in the flow cell. This is indicated by 
excessive noise in the forward scatter parameter. In these cases, it is necessary to 
prime the fluidics system.

1 Remove the tube from the SIP.

2 Press the PRIME fluid control button to force the fluid out of the flow cell 
and into the waste container.

Once drained, the flow cell automatically fills with sheath fluid at a 
controlled rate to prevent bubble formation or entrapment. The STNDBY 
button is amber after completion.

3 Install a 12 x 75-mm tube with 1 mL of DI water on the SIP and place the 
support arm under the tube.

4 Repeat the priming procedure, if needed.

Quality Control

An instrument quality control (QC) procedure, performed on a regular basis, 
provides a standard for monitoring instrument performance. Instrument QC 
consists of running QC samples and recording parameter means and CVs.

QC data should be analyzed for trends involving 10 or more runs. By keeping the 
instrument settings and QC sample constant, changes in the recorded means and 
CVs will indicate how much instrument performance varies over time. 

QC results are affected by laser and fluidics performance. We strongly 
recommend following the laser and fluidics maintenance procedures in 
Chapter 6.

See QC Particles on page 150 for a list of acceptable QC beads.

A sample QC log is provided in Appendix B. It can be photocopied or used as a 
guide in designing your own QC log.
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3

Running Samples

This chapter describes procedures that use BD FACSDiva software to record and 
analyze sample data:

• Sample Optimization Using Instrument Setup on page 52

• Recording and Analyzing Data on page 65
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Before You Begin

Before attempting to perform the procedures in this chapter, you should be 
familiar with:

• BD LSR II instrument startup, setup, and QC procedures (see Chapter 2, 
Instrument Setup on page 37)

• BD FACSDiva software concepts: workspace components, instrument and 
acquisition controls, tools for data analysis.

To become familiar with BD FACSDiva software, perform the tutorial 
exercises in Getting Started with BD FACSDiva Software.

For additional details, refer to the BD FACSDiva Software Reference 
Manual.

Sample Optimization Using Instrument Setup

Before you record data for a sample, optimize the following for the sample type 
and fluorochromes used:

• PMT voltages

• threshold setting

• compensation values

This section describes how to optimize samples using the Instrument Setup 
feature of BD FACSDiva software. In particular, instrument setup automatically 
calculates compensation settings. If you choose to perform compensation 
manually, not all of the instructions given below will apply. For detailed 
instructions, refer to the BD FACSDiva Software Reference Manual.
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Sample optimization consists of several main steps, to be performed in the order 
listed below. Each of the steps is explained in greater detail in the sections that 
follow.

1 Verify instrument configuration and user preferences.

2 Create an experiment.

3 Adjust voltages and the threshold setting.

4 Record the compensation tubes.

5 Calculate compensation settings.

The data shown in this example is from a 4-color bead sample with the following 
fluorochromes:

• FITC

• PE

• PerCP

• APC

To perform the example exercise shown here, prepare an unstained control tube 
and single-stained tubes for each fluorochrome.

If you follow this procedure with a different bead sample (or another sample 
type), your software views, data plots, and statistics might deviate from those 
shown here. Additionally, you might need to modify some of the instructions in 
the procedure.
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Verifying Instrument Configuration and User 
Preferences

To obtain accurate data results, the current BD FACSDiva software instrument 
configuration must reflect your BD LSR II instrument optics. Verify the 
configuration and preferences before you create an experiment.

1 Choose Instrument > Instrument Configuration and verify the current 
configuration. 

Figure 3-1 shows an Instrument Configuration dialog whose current 
configuration is the standard default configuration.

Figure 3-1  Instrument Configuration dialog

Check that the configuration includes the parameters to be measured and 
that the channels correspond to the optical mirrors and filters. For our bead 
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sample, the instrument configuration includes the following parameters: 
FITC, PE, PerCP, and APC.

2 Choose Edit > User Preferences. 

• Verify that the settings under the General tab match those displayed in 
Figure 3-2 (all checkboxes deselected).

Figure 3-2  User Preferences dialog

• Under the Templates tab, verify that the Default global worksheet 
checkbox is enabled.

Refer to the BD FACSDiva Software Reference Manual for more information 
about instrument configuration and user preferences.
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Creating an Experiment

In this section, you create an experiment in a new folder, specify the parameters 
for instrument setup, and add compensation tubes.

1 Click the corresponding buttons in the Workspace toolbar to display the 
Browser ( ), Instrument ( ), Inspector ( , Worksheet ( ), and 
Acquisition Dashboard ( ) windows, as needed.

2 Add a new folder to the Browser ( ); rename the folder MyFolder.

Tip     To place an experiment inside a folder, select the folder before you 
create the experiment.

3 Create an experiment inside MyFolder, and rename the experiment 
MyExperiment.

4 With the experiment selected in the Browser, verify in the Inspector that the 
Use global instrument settings checkbox is checked.

Figure 3-3  Use global instrument settings checkbox

5 Specify the parameters for instrument setup.

• In the Browser, select the Instr Settings of MyExperiment.

• Make sure the parameters you need appear on the Parameters tab in 
the Inspector.
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If more than one parameter is available for a particular PMT, you 
might have to select the one you need from a menu.

For this example, choose PerCP from the PerCP-Cy5-5 menu.

• Delete any unnecessary parameters.

To delete a parameter, select it (by clicking the selection button to the 
left of the parameter name), and then click the Delete button.

• Verify that Log is deselected for the FSC and SSC parameters, and is 
selected for each fluorescence parameter.
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• Verify that A (area) is selected for every parameter, and that H (height) 
and W (width) are deselected for every parameter.

6 Choose Instrument > Instrument Setup > Create Compensation Controls. 

The Create Compensation Controls dialog is displayed (Figure 3-4). 

• Verify that the Include separate unstained control tube/well checkbox 
is selected, and that the compensation control tube list matches the 
fluorescent parameters selected in step 5 above.

For this bead example, you do not need to provide non-generic tube 
labels. 

• Click OK to create the control tubes.

Figure 3-4  Create Compensation Controls dialog
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Compensation controls are added to the experiment, along with a single 
stained control tube for each parameter in the experiment, and an 
unstained control tube (Figure 3-5). Worksheets containing appropriate 
plots and gates are added for each compensation tube.

Figure 3-5  Compensation tubes

Adjusting the Voltages and Threshold

In this section, you use the unstained control tube to adjust FSC and SSC voltages 
and FSC threshold, to gate the population of interest (bead singlets, in this case), 
and to adjust fluorescence PMT voltages.

1 Install the unstained control tube on the cytometer. 

2 Expand the Compensation Controls specimen in the Browser.

3 Click to set the current tube pointer next to the unstained control tube (it 
becomes green) and click Acquire Data.

4 Adjust the FSC and SSC voltages to appropriately position the singlet bead 
population for gating (Figure 3-6 on page 60).

• Click the Parameters tab in the Instrument window. 

• Use the up and down arrows or drag the voltage sliders to adjust the 
voltage settings.

5 Click the Threshold tab and adjust the FSC threshold, if needed.

Adjust the FSC Threshold to remove most of the debris without clipping 
the singlet population (Figure 3-6 on page 60).
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6 Adjust the P1 gate on the Unstained Control worksheet, as needed, to 
encompass only the singlet population (Figure 3-6). 

Tip     To quickly adjust the gate, right-click the gate boundary, and choose 
Recalculate. 

Figure 3-6  P1 gate adjusted to singlet population

7 Right-click the gate and choose Apply to All Compensation Controls.

The P1 gate on each Stained Control worksheet is updated with your 
changes.
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8 Display log decade gridlines on the fluorescence histograms.

• Select all fluorescence histograms on the Unstained Control worksheet.

• In the Plot Inspector, select the Grid checkbox (Figure 3-7).

Figure 3-7  Inspector for fluorescent plots

In a four decade log display, values are displayed from 26–262,143. The 
first log decade ranges from 26–262. Gridlines are used to delineate log 
decades on plots. 

9 For each fluorescence parameter, adjust PMT voltages to place the negative 
population within the first log decade (Figure 3-8 on page 62).

To adjust voltage settings, use controls in the Parameters tab in the 
Instrument window. Refer to the BD FACSDiva Software Reference 
Manual for assistance.
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Figure 3-8  Unstained Control worksheet plots after PMT adjustment

10 Click Record Data; when all events have been recorded, remove the 
unstained control tube from the cytometer.

Do not change the PMT voltages after the first compensation control has 
been recorded. In order to calculate compensation, all controls must be 
recorded with the same PMT voltage settings. If you need to adjust the 
PMT voltage for a subsequent compensation control, you will need to 
record all compensation controls again.
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Calculating Compensation

Before you can calculate compensation, you need to record data for each single-
stained control.

1 Install the first stained control tube onto the cytometer.

2 In the Acquisition Dashboard, click Next Tube, and then Acquire Data.

Alternatively, move the current tube pointer to the next tube and click the 
pointer to start acquisition.

3 Click Record Data, or Alt-click the current tube pointer to record data.

4 When recording is finished, install the next stained control tube onto the 
cytometer.

5 Repeat steps 2 through 4 until data for all stained control tubes has been 
recorded.

6 Double-click the first stained control tube (FITC stained control) to display 
the corresponding worksheet.

7 Verify the snap-to interval gate surrounds the fluorescence-positive peak on 
the histogram (Figure 3-9). 

Adjust the gate, if needed.

Figure 3-9  Gating the positive population

8 Repeat steps 6 and 7 for the remaining compensation tubes.
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9 Choose Instrument > Instrument Setup > Calculate Compensation.

If the calculation is successful, a dialog is displayed where you can enter a 
name for the compensation setup.

10 Enter a setup name, and click OK. 

Tip     To help track compensation setups, include the experiment name, 
date, or both in the setup name.

The compensation setup is linked to the MyExperiment instrument 
settings, and subsequent acquisitions in MyExperiment are performed with 
the new compensation settings.

NOTICE     BD Biosciences recommends that you always visually and statistically 
inspect automatically calculated overlap values. The means of the positive 
controls should be aligned with the means of the negative.
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Recording and Analyzing Data

This section outlines some basic acquisition and analysis tasks using 
BD FACSDiva software. The example shows data from two 4-color bead samples 
with the following fluorochromes:

• FITC

• PE

• PerCP

• APC

The procedure builds on the results obtained in the previous exercise: Sample 
Optimization Using Instrument Setup on page 52. To perform this procedure, 
prepare two tubes containing all four fluorochromes.

If you use a different sample type (or if you have skipped the optimization 
exercise), your software window content and your data plots and statistics may 
deviate from those shown here. You might also need to modify some of the 
instructions in the procedure.

For additional details on completing some of the steps below, refer to the 
BD FACSDiva Software Reference Manual.

Preparing the Workspace

In this section, you prepare your workspace before recording data.

1 Using the Browser toolbar, create a new specimen in MyExperiment and 
rename it FourColorBeads.

2 Create two tubes for the FourColorBeads specimen. Rename the tubes 
Beads_001 and Beads_002.

3 Expand the Global Worksheets folder in MyExperiment to access the 
default global worksheet, and rename the worksheet MyData.
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4 Choose Experiment > Experiment Layout to display the Experiment 
Layout dialog. 

Use this dialog to define parameter labels and to specify the number of 
events to record for each tube.

Parameter labels appear on the plot axes and in all statistics views. For 
these bead samples, you do not need to define additional parameter labels. 
When you record immunophenotyping data, use the Labels tab of the 
Experiment Layout dialog to provide reagent antibody labels.

• Click the Acquisition tab. Verify the number of events to acquire is set 
to 10,000 for both tubes.

• Click OK.
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5 On the MyData worksheet, create some plots for previewing data:

• FSC vs SSC

• FITC vs PE

• FITC vs PerCP

• FITC vs APC

Tip     Double-click the Dot Plot button to keep the button selected until you 
create all plots.

Recording Data

In this section, you preview and record data for multiple samples.

1 Install the first sample tube on the cytometer.

2 Move the current tube pointer to Beads_001. 

3 Click Acquire Data in the Acquisition Dashboard to begin acquisition. 

4 While data is being acquired:

• Draw a gate around the singlets on the FCS vs SSC plot.

• Rename the P1 gate to Singlets.

• Use the Inspector to set the other plots to show only the singlet 
population.

5 Click Record Data.
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6 When event recording has completed, remove the first tube from the 
cytometer. 

The MyData worksheet plots should resemble those in Figure 3-10.

Figure 3-10  Recorded data showing singlet population

7 Install the second sample tube on the cytometer.

8 Move the current tube pointer to Beads_002.

9 Click Acquire Data to begin acquisition.

Before recording, preview the data on the MyData worksheet.

10 Click Record Data.

11 When event recording has completed, remove the second tube from the 
cytometer.
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12 If you are recording more than two tubes, repeat steps 7 through 11 for the 
additional tubes.

13 Print the experiment-level instrument settings.

Right-click the Instr Settings icon and choose Print.

Analyzing Data

In this section, you analyze the recorded tubes by creating plots, gates, a 
population hierarchy, and statistics views on a new global worksheet. When 
complete, your new global worksheet should resemble that in Figure 3-11 on 
page 72.

1 Use the Browser toolbar to create a new global worksheet; name it 
MyDataAnalysis.

2 Create the following plots on the MyDataAnalysis worksheet:

• FSC vs SSC

• FITC vs PE

• FITC vs PerCP

• FITC vs APC

3 Create a population hierarchy and a statistics view, and move them below 
the plots on the worksheet.

• Choose Populations > Show Population Hierarchy. 

• Choose Populations > Create Statistics View. 

4 Move the current tube pointer to Beads_001.

5 Draw a gate around the singlets on the FSC vs SSC plot. 

6 Use the population hierarchy to rename the population Singlets.
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7 Select all plots except the FSC vs SSC plot, and use the Plot tab in the 
Inspector to specify to show only the singlet population.

8 Select all plots, and click the Title tab in the Inspector; select the Tubes and 
Populations checkboxes to display their names in plot titles.

9 On all fluorescence plots:

• Draw a gate around the FITC-positive population, for the first plot 
only, and name the population FITC positive.

• Draw a gate around the PE-positive population, and name the 
population PE positive.

• Draw a gate around the PerCP-positive population, and name the 
population PerCP positive.

• Draw a gate around the APC-positive population, and name the 
population APC positive.
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10 Format the Statistics view.

• Right-click the Statistics view and choose Edit Statistics View.

• Click the Header tab, and select the Specimen Name and Tube Name 
checkboxes.

• Click the Populations tab, and select all populations except All Events; 
deselect the %Parent, %Total, and # Events checkboxes.

• Click the Statistics tab, and select the mean for each of the fluorescence 
parameters.

• Click OK.

11 Print the analysis.

Your global worksheet analysis objects should now resemble those in 
Figure 3-11 on page 72.
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Figure 3-11  Bead analysis
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Reusing the Analysis

Global worksheets allow you to apply the same analysis to a series of recorded 
tubes. Once you define an analysis for a tube, use it to analyze the remaining 
tubes in the experiment. After viewing the data, print the analysis or save it to a 
tube-specific worksheet (see Saving the Analysis).

1 Move the current tube pointer to the tube Beads_002.

2 View the Beads_002 data on your analysis worksheet. Adjust gates as 
needed.

Tip     Adjustments will apply to subsequent tubes viewed on the worksheet. 
Avoid altering a global worksheet by saving an analysis to a tube-specific 
worksheet, and making adjustments on the tube-specific worksheet.

3 Print the analysis.

Saving the Analysis

When an analysis is performed with a global worksheet, the analysis is not saved 
with the tube.

Tip     If you define your analysis on a global worksheet before recording data, you 
can specify to automatically save the analysis after recording data. This option is 
set in user preferences.

To save a copy of the analysis of Beads_001 with that tube:

1 Expand the MyDataAnalysis global worksheet icon in the Browser.

2 Right-click on its analysis and select Copy.

3 Click the Worksheets View button ( ) on the Worksheet toolbar to switch 
to the normal (tube-specific) worksheet view.

4 Choose Worksheet > New Worksheet to create a new normal worksheet.
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5 Click in the new worksheet; use the Worksheet Inspector to rename it 
Beads_001_Analysis.

6 Right-click the Beads_001 tube icon in the Browser, and choose Paste.

The analysis objects from the MyDataAnalysis global worksheet are copied 
to the Beads_001_Analysis normal worksheet. View the analysis by double-
clicking the Beads_001 tube icon in the Browser.

Tip     Apply the global worksheet analysis to multiple tubes (on a single 
normal worksheet) by selecting more than one tube before you paste the 
analysis.
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4

DNA Analysis

The following topics are covered in this chapter:

• Criteria for DNA Experiments on page 76

• CEN Optimization on page 78

• CTN Resolution on page 84

• Optimization for Data Recording on page 86
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Criteria for DNA Experiments

To support DNA experiments, a flow cytometer must provide:

• ability to resolve histogram peaks (populations)

• linearity of the DNA fluorescence signal

• ability to distinguish singlets from aggregates

While obtaining good peak resolution for DNA also depends on proper sample 
preparation, optimization of instrument optics and fluidics is critical. A flow 
cytometer’s ability to resolve peaks can be assessed by measuring the CV of a 
reference particle: the lower the CV, the better the resolution.

Linearity is also critical for DNA experiments. To assess the linearity of DNA 
data, the pulse-area signal is used to measure the amount of DNA fluorescence 
detected from cells or nuclei. On an instrument with good linearity, the doublet 
peak should be located at twice the mean channel of the singlet peak (Figure 4-1).

Figure 4-1  Area signal and DNA fluorescence

_
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Doublet discrimination, or the ability to distinguish singlets from aggregates, is 
also important for DNA experiments. Since doublets of G0/G1 cells have the 
same amount of DNA fluorescence as singlet G2+M cells, they accumulate in the 
same fluorescence area channels (Figure 4-1 on page 76). Therefore, singlets and 
doublets must be distinguished to obtain cell-cycle analysis accuracy. Signal 
width vs area can be employed to accurately identify aggregate events. 

DNA Setup

In this chapter, you use the BD™ DNA QC Particles kit to verify critical DNA 
analysis criteria, and optimize your cytometer for DNA experiments. The 
instructions given here assume that DAPI is being used as described in How to 
Use DAPI with DNA QC, below. If you are using PI for DNA QC, see How to 
Use PI with DNA QC, and substitute PI for DAPI in subsequent instructions.

How to Use DAPI with DNA QC

Before beginning this chapter, do the following.

• Prepare biological standards for instrument quality control using the 
BD DNA QC Particles kit. Substitute the PI solution in the BD DNA QC 
Particles kit with a 1.0-nanomolar (nM) DAPI solution prepared in 
1% BSA.

• Prepare one tube each of chicken erythrocyte nuclei (CEN) and calf 
thymocyte nuclei (CTN) sample according to the kit instructions. Substitute 
the DAPI solution for the PI solution.

- The CEN sample is used to check instrument resolution (CV) and 
linearity.

- The CTN sample is used to verify the system’s ability to resolve singlets 
from aggregates.
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How to Use PI with DNA QC

You can use the PI that comes with the BD DNA QC Particles kit instead of 
DAPI. To do so, prepare the CEN and CTN samples as described in the kit 
instructions. 

CEN Optimization

Use the following procedure to set up BD FACSDiva software for a DNA 
experiment that uses DAPI as the DNA-staining dye. If you are using another 
sample type, modify the steps accordingly. If you are using PI, substitute PI for 
DAPI throughout the procedure.

Preparing the Workspace

1 Choose Instrument > Instrument Configuration and verify the current 
configuration. 

Figure 3-1 on page 54 shows an Instrument Configuration dialog whose 
current configuration is the standard default configuration.

Verify that DAPI appears in the current configuration.

For accurate data results, the Instrument Configuration dialog box must 
reflect the physical layout of the BD LSR II octagons and trigons. 
Modifications to the current configuration will not apply unless you click 
Set Configuration.

2 Choose Edit > User Preferences. 

Verify that under the General tab, all checkboxes are deselected (Figure 3-2 
on page 55).

Refer to the BD FACSDiva Software Reference Manual for more 
information about the instrument configuration and user preferences.

3 Create a new experiment and rename it DNA.
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4 With the DNA experiment icon selected, verify in the Inspector that the Use 
global instrument settings checkbox is checked (Figure 3-3 on page 56).

5 Select the Instr Settings icon in the DNA experiment, and use the Inspector 
to specify the parameters and threshold setting for your experiment.

• Click the Parameters tab in the Inspector.

• For this experiment, delete all parameters except FSC, SSC, and DAPI.

• Verify that the Log checkbox is deselected for all parameters.

• For DAPI, verify that the A (area) checkbox is selected, and select the 
W (width) checkbox.

• Click the Threshold tab and change the threshold parameter to DAPI; 
verify that the threshold value is set to 5,000.
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6 Create a new specimen in the DNA experiment and rename it DNA QC 
Kit. 

7 Open the specimen to access its tube. Rename the tube CEN, and move the 
current tube pointer to CEN.

Your experiment should look similar to the figure below.

 

8 Create a normal worksheet for the CEN tube with the following plots:

• FSC-A vs SSC-A dot plot

• DAPI-A vs DAPI-W dot plot

• DAPI-A histogram

9 Create a statistics view and display the mean and CV for DAPI-A and 
DAPI-W.

• Choose Populations > Create Statistics View.

• Right-click on the Statistics view and select Edit Statistics View.

• On the Population tab, deselect #Events and %Parent.

• On the Statistics tab, select the mean and CV for both DAPI-A and 
DAPI-W, and set Decimal Places to 1 for the CVs (Figure 4-2 on 
page 81).
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Figure 4-2  Edit Statistics view

• Click OK.

10 In the Acquisition Dashboard, set the Events to Record to 10,000 and the 
Events to Display to 500.
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Running CEN

1 On the BD LSR II cytometer control panel, press RUN and LO.

2 Install the CEN sample tube on the SIP.

3 Verify that the green current tube pointer is in front of the CEN tube in the 
Browser. 

4 In the Acquisition Dashboard, click Acquire Data.

5 Adjust the FSC and SSC voltages to place the CEN on scale in the FSC vs 
SSC dot plot.

Figure 4-3  FSC and SSC voltages adjusted

6 Adjust the DAPI voltage to place the singlet nuclei at approximately 
channel 50 x 103 on the DAPI-A axis in the DAPI-A histogram plot 
(Figure 4-4 on page 83).

7 Adjust the event rate (displayed in the Acquisition Dashboard) to 
approximately 200 events/second with the SAMPLE FINE ADJ knob.

8 Draw Interval gates around the first two peaks on the DAPI-A histogram. 
Name the populations Singlets and Doublets (Figure 4-4 on page 83). 
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Figure 4-4  Defining singlet and doublet populations

9 In the Acquisition Dashboard, click Record Data.

10 When recording finishes, note the CV of the Singlet population.

• If the CV is ≤3%, continue to step 11.

• If the CV is >3%, restart the acquisition. Decrease the flow rate with 
the SAMPLE FINE ADJ knob until the CV is ≤3%, and then re-record 
the data. 

If the CV does not improve, see Troubleshooting on page 113.

CV <3%
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11 Verify the linearity and print the worksheet.

• Divide the mean of the Doublet population by the mean of the Singlet 
population. The mean ratio should be 2.00 +/-0.05. If you do not 
achieve a ratio between 1.95–2.05, contact BD Customer Support.

• Copy the population means and CVs, and the calculated linearity result 
into your QC log.

12 Remove the CEN sample from the cytometer.

CTN Resolution

Singlets can be distinguished from aggregates based on size. With BD FACSDiva 
software, aggregates can be resolved from singlets on an area vs width plot. With 
this plot, singlets are distinguished from doublets by the width measurement; 
singlets have a smaller width measurement. Discriminating the singlets from the 
aggregates enhances the accuracy of cell-cycle analysis.

Running CTN

1 On the BD LSR II cytometer control panel, press RUN and LO.

2 Install the CTN sample tube on the cytometer.

3 Adjust the event rate to approximately 500 events/second.

4 Click Next Tube in the Acquisition Dashboard. 

A new tube is created under the DNA QC Kit specimen. 

5 Change the name of the tube to CTN.

The Next Tube button duplicates the CEN tube and 
analysis objects. The new plots and statistics view 
appear below the previous objects on the worksheet. 
Acquisition for the CTN tube starts automatically.
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6 Adjust the DAPI voltage to place the first peak at approximately channel 
50 x 103 on the DAPI-A axis.

Figure 4-5  Doublet discrimination with unzoomed plot

7 Use the Zoom-In button to magnify the area showing the singlets and 
doublets on the DAPI-A vs DAPI-W plot (Figure 4-6).

Figure 4-6  Doublet discrimination with zoomed plot

If you are unable to distinguish the singlet and doublet populations, see 
Chapter 7, Troubleshooting.

doublets

singlets

singlets

doublets
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8 Draw a gate around the singlet CTN events.

9 Adjust the event rate to approximately 200 events/second with the 
SAMPLE FINE ADJ knob.

10 Click Record Data to save the data.

11 Print the worksheet.

12 Remove the CTN tube from the cytometer and put the instrument in 
standby mode.

Optimization for Data Recording

Optimize the instrument settings for the actual sample.

1 Install the sample tube and adjust the FSC and SSC voltages to place the 
data events on scale.

2 Adjust the DAPI voltage to place the singlet diploid events at about channel 
50 x 103.

After optimizing the instrument settings, record data for each sample tube. 
BD FACSDiva software does not include DNA analysis algorithms. Export your 
data files for analysis in a third-party application such as ModFit LT™. 
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5

Calcium Flux

The following topics are covered in this chapter:

• Intracellular Calcium Concentration on page 88

• Calcium Flux Optimization on page 89

• Recording Calcium Flux Data on page 96
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Intracellular Calcium Concentration

Flow cytometry can be used to measure the concentration of intracellular free 
calcium ions. Measurement of calcium ion (Ca++) concentration can be made on 
large numbers of single cells, which provides information about the number of 
responding cells as well as the relative magnitude of the response to a given 
stimulus. Ca++ concentration can be correlated with other parameters, such as 
time, phenotype, and cell cycle.

In their resting state, eukaryotic cells maintain an internal Ca++ concentration far 
less than that of the extracellular environment. Elevation in intracellular Ca++ 
concentration is often used as an indicator of cellular activation in response to a 
stimulus. Calcium flux is also an indicator of whether the cells in a population 
remain functional after exposure to a drug or other compound.

Several fluorescent dyes measure intracellular Ca++ levels. For most of them, the 
amount of Ca++ entering a cell is indicated by a change in fluorescence emission. 
For example, the emission spectrum of indo-1 changes from blue to violet upon 
binding to Ca++. The ratio of violet to blue fluorescence is independent of the 
amount of dye within the cell.

When normal cells are analyzed for calcium flux with indo-1 by flow cytometry, 
a shift in the violet/blue ratio is obtained (Figure 5-1). A break in data occurs 
when the stimulus is added to the sample tube. The increase in the ratio over time 
reflects the increase in intracellular Ca++ concentration.

Figure 5-1  Calcium flux data
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Calcium Flux Optimization

Before beginning this section, do the following:

• Start up the instrument and perform QC.

• Ensure that the appropriate filters are installed. See Setting Up the Optical 
Filters and Mirrors on page 39.

• Review the following section, Using the Time Parameter.

Tip     For calcium-flux experiments, use a sheath fluid that does not contain 
preservatives. For example, use 1X phosphate-buffered saline (PBS).

Using the Time Parameter

The Time parameter shows how events change over time. In calcium flux 
experiments, the Time parameter displays the rate at which the cells in the sample 
respond to a stimulus. 

The Time parameter is a fixed scale and cannot be altered. The values for the 
Time parameter are in 10-ms increments; thus for a given event, a Time 
parameter of 123 represents 1,230 ms. Because a plot spans 2.6–262,143, 
tickmarks will span 2.6–2,621,430 ms (or 44 minutes). Therefore, it takes an 
event approximately 44 minutes to travel from one end of a plot to the other. 

Tip     Do not restart data recording during a calcium flux experiment; data will 
be lost.
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Setting Up the Experiment

1 Choose Instrument > Instrument Configuration and verify the current 
configuration. 

Figure 3-1 on page 54 shows an Instrument Configuration dialog whose 
current configuration is the standard default configuration.

Verify that Indo-1 (Violet) and Indo-1 (Blue) appear in the current 
configuration.

For accurate data results, the Instrument Configuration dialog must reflect 
the physical layout of the BD LSR II octagons and trigons. Modifications to 
the current configuration will not apply unless you click Set Configuration.

2 Choose Edit > User Preferences. 

Verify that under the General tab, all checkboxes are deselected (Figure 3-2 
on page 55).

Refer to the BD FACSDiva Software Reference Manual for more 
information about the instrument configuration and user preferences.

3 Create a new experiment and rename it CalciumFlux.

4 With the CalciumFlux experiment icon selected, verify in the Inspector that 
the Use global instrument settings checkbox is checked (Figure 3-3 on 
page 56).
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5 Select the Instr Settings icon in the CalciumFlux experiment, and use the 
Inspector to specify parameters and settings for your experiment.

• Make sure the parameters you need appear on the Parameters tab.

If more than one parameter is available for a particular PMT, you 
might have to select the one you need from a menu.

For the example shown here, choose Indo-1(Violet) from the DAPI 
menu.

• For this experiment, delete all parameters except FSC, SSC, Indo-1 
(Blue), and Indo-1 (Violet).

• Verify that the Log checkbox is deselected for all parameters.

• Verify that the A (area) checkbox is selected for Indo-1 (Blue) and 
Indo-1 (Violet).
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• Within the Ratio tab, click the Add button. Select Indo-1 (Violet)-A for 
the Numerator, and Indo-1 (Blue)-A for the Denominator.

6 Create a new specimen in the CalciumFlux experiment. 

7 Open the specimen to access its tube. Rename the tube CaF_001, and move 
the current tube pointer to CaF_001.

At this point, your experiment should look similar to this one.

 

8 Create a normal worksheet for the CaF_001 tube with the following dot 
plots:

• FSC-A vs SSC-A

• Indo-1 (Blue)-A vs Indo-1 (Violet)-A

• Time vs Ratio: Indo-1 (Violet)-A/Indo-1 (Blue)-A
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9 Select all plots. Click the Title tab in the Inspector and select the Tubes and 
Populations checkboxes to display their names in plot titles.

10 Create a statistics view and display the mean for Indo-1 (Blue)-A, Indo-1 
(Violet)-A, and the ratio parameter.

• Choose Populations > Create Statistics View.

• Right-click on the Statistics view and select Edit Statistics View.

• Under the Population tab, deselect #Events and %Parent.

• Under the Statistics tab, select the mean for Indo-1 (Blue)-A, Indo-1 
(Violet)-A, and the ratio parameter.

• Click OK.

11 In the Acquisition Dashboard, set the Events To Record to 1,000,000, the 
Events To Display to 500, and the Stopping Time to 360 seconds.
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Only the specified number of Events to Display are shown during 
acquisition and recording. After data recording is complete, all recorded 
events will be displayed. 

Optimizing for Calcium Flux

1 On the control panel, press RUN and LO.

2 Install the sample (not yet stimulated) on the SIP.

3 Verify that the green current tube pointer is in front of the CaF_001 tube in 
the Browser. In the Acquisition Dashboard, click Acquire Data.

4 Adjust the FSC and SSC voltages to place the lymphocytes on scale in the 
FSC vs SSC dot plot.

5 Adjust the FSC threshold to remove debris without cutting into the 
lymphocyte population.

6 Draw a gate around the lymphocytes. 

7 Create a population hierarchy view and rename the population 
Lymphocytes.

Figure 5-2  Lymphocyte gate
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8 Display only the lymphocyte population in the remaining two dot plots.

Select the two plots, right-click inside one of the plots and choose Show 
Populations > Lymphocytes.

9 Adjust the Indo-1 (Violet)-A and the Indo-1 (Blue)-A voltages to optimize 
the signal.

The signal, when displayed in the plot, should resemble that of Figure 5-3.

Figure 5-3  Optimized Indo-1 signal

10 Set the mean of the ratio parameter to about 50,000.

• Select the CaF_001 tube in the Browser and click the Ratio tab in the 
Inspector.

• Adjust the value in the Scaling (%) field (a higher percentage will raise 
the mean) until the mean of the ratio parameter is about 50,000 (use 
the statistics view). 
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Your time vs ratio plot should resemble this:

Recording Calcium Flux Data

1 In the Acquisition Dashboard, change the Events to Display to 50,000 
events.

2 Verify that the unstimulated sample is still running. 

3 Use the cytometer’s SAMPLE FINE ADJ knob to adjust the event rate to 
about 200 events/second.

The event rate is displayed in the Acquisition Dashboard. 

4 Click Record Data.

NOTICE     Keep the instrument in RUN mode as you perform steps 5 
through 7 below. Do not stop recording. The unstimulated sample data 
must be maintained. If recording is stopped, ensure that the subsequent 
data is appended to the unstimulated sample data.

5 When approximately 10,000 events have been recorded, remove the 
unstimulated sample tube from the cytometer.

6 Add the stimulus to the tube and mix thoroughly.
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7 Reinstall the tube on the SIP.

After a few seconds, the Ca++ concentration begins to increase on the 
time vs ratio plot (Figure 5-4). Acquisition stops automatically when the 
Stopping Time is reached.

Figure 5-4  Cellular response to stimulus over time 

8 Remove the tube from the cytometer.

9 Clean the fluidics system with 10% bleach for 5 minutes, and then with DI 
water for 5 minutes.

Tip     Residual stimulus must be removed from the system. Any remaining 
stimulus would activate cells in subsequent samples.

10 To run another sample, install the next sample tube on the SIP.

11 In the Acquisition Dashboard, click Next Tube to create a new tube, and 
rename the new tube appropriately. 

12 Repeat steps 3 through 11.

BD FACSDiva software does not include calcium flux analysis algorithms. 
Export your data files for analysis in a suitable third-party application.

unstimulated stimulus
addedsample 
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6

Maintenance

• Daily Cleaning and Shutdown on page 100

• Scheduled Maintenance on page 103

• Periodic Maintenance on page 107
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The BD LSR II instrument is designed to require minimum maintenance. 
However, to preserve the reliability of the instrument, you must regularly 
perform basic preventive maintenance procedures. This chapter explains routine 
cleaning procedures that will keep your instrument in good condition.

Tip     A 5% solution of sodium hypochlorite can be substituted for undiluted 
bleach in the following cleaning procedures. However, higher concentrations of 
sodium hypochlorite and use of other cleaning agents might damage the 
instrument.

Daily Cleaning and Shutdown

Perform the following maintenance procedures every day:

• Daily Fluidics Cleaning on page 100

• Daily Shutdown on page 102

Daily Fluidics Cleaning

Each time you shut down the instrument, clean the sample injection tube and the 
area between the injection tube and the outer sleeve (Figure 6-1 on page 101). 
This prevents the sample injection tube from becoming clogged and removes dyes 
that can remain in the tubing.

Tip     Follow this procedure immediately after running viscous samples or nucleic 
acid dyes such as Hoechst, DAPI, propidium iodide (PI), acridine orange (AO), or 
thiazole orange (TO).

All biological specimens and materials coming into contact with them are 
considered biohazardous. Handle as if capable of transmitting infection. 
Dispose of waste using proper precautions and in accordance with local 
regulations. Never pipette by mouth. Wear suitable protective clothing, 
eyewear, and gloves.
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Figure 6-1  Sample injection port (SIP)

1 Set the fluid control to RUN.

2 Install a tube containing 3 mL of a bleach solution on the SIP with the 
support arm to the side (vacuum on) and let it run for 1 minute.

Tip     For the bleach solution, use BD™ FACSClean solution or a 1:10 
dilution of bleach in DI water.

BD FACSClean solution is a bleach-based cleaning agent designed for daily 
use in cytometer maintenance.

3 Move the support arm under the tube (vacuum off) and allow the bleach 
solution to run for 5 minutes with the event rate set to HI.

4 Repeat steps 2 and 3 with BD™ FACSRinse solution.

BD FACSRinse solution is a detergent-based cleaning solution.

5 Repeat steps 2 and 3 with DI water.

6 Set the fluid control to STNDBY.

tube stop

Bal seal

outer sleeve

tube support arm

sample injection tube
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7 Place a tube containing no more than 1 mL of DI water on the SIP.

A tube with 1 mL of DI water should remain on the SIP to prevent salt 
deposits from forming in the injection tube. This tube also catches back 
drips from the flow cell.

Tip     Do not leave more than 1 mL of water on the SIP. When the 
BD LSR II flow cytometer is turned off or left in STNDBY mode, a small 
amount of fluid will drip back into the sample tube. If there is too much fluid 
in the tube, it could overflow and affect instrument performance.

8 Set the cytometer to STNDBY mode.

Daily Shutdown

1 Turn off the flow cytometer.

2 Choose Start > Shutdown to turn off the computer, if needed.

Tip     If the instrument will not be used for a week or longer, perform a system 
flush (see System Flush on page 103) and leave the fluidics system filled with DI 
water to prevent saline crystals from clogging the fluidics.
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Scheduled Maintenance

Perform the following maintenance procedures every 2 weeks:

• System Flush on page 103

• Waste Management System Maintenance on page 105

System Flush

An overall fluidics cleaning is required to remove debris and contaminants from 
the sheath tubing, waste tubing, and flow cell. Perform the system flush at least 
every 2 weeks.

1 Remove the sheath filter.

• Press the quick-disconnects on both sides of the filter assembly.

• Remove the filter assembly.

• Connect the two fluid lines.

Tip     Do not run detergent, bleach, or ethanol through the sheath filter. 
They can break down the filter paper within the filter body, causing particles 
to escape into the sheath fluid, possibly clogging the flow cell.

2 Empty the sheath container and rinse it with DI water.

3 Fill the sheath container with at least 1 L of a 1:10 dilution of bleach or 
full-strength BD FACSClean solution.

4 Empty the waste container if needed.

Instrument hardware might be contaminated with biohazardous material. 
Use 10% bleach to decontaminate the BD LSR II flow cytometer. Flushing 
with 10% bleach is the only procedure recommended by BD Biosciences for 
decontaminating the instrument.
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5 Open the roller clamp by the fluidics interconnect, and drain the fluid into 
a beaker for 5 seconds.

6 Remove the DI water tube from the SIP.

7 Prime twice (perform the following twice):

• Press the PRIME button on the fluidics control panel. 

• When the STNDBY button lights (amber), press the PRIME button 
again.

8 Install a tube with 3 mL of a 1:10 dilution of bleach or full-strength 
BD FACSClean solution on the SIP.

9 Press the RUN fluid control button; run the cytometer on HI for 30 
minutes.

10 Press the STNDBY fluid control button and depressurize the sheath 
container by lifting the vent valve.

11 Repeat steps 2 through 10 with BD FACSRinse solution in place of the 
bleach solution.

12 Repeat steps 2 through 10 with DI water in place of the BD FACSRinse 
solution.

13 Replace the sheath filter and refill the sheath container with sheath fluid.
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Waste Management System Maintenance

The waste management system for the BD LSR II instrument has an alarm 
powered by a 9-volt battery that must be tested and changed regularly to ensure 
its continued operation. Test the battery every 2 weeks after you flush the system; 
see the following section. Change the battery as needed; see Changing the Battery 
on page 106

Testing the Battery and Alarm

1 Locate the Battery Test switch on the waste container bracket (Figure 6-2).

Figure 6-2  Battery Test switch

2 Toggle the switch.

If the battery and the alarm are working properly, you should hear buzzing. 
If you do not hear any sound, change the battery as described in the 
following section.

3 Release the switch.
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Changing the Battery

You will need the following supplies to change the battery:

• small flat-head screwdriver

• 9-volt battery

Perform the following steps.

1 Insert the tip of a flat-head screwdriver into the slot as shown in Figure 6-3 
and pry it out.

A small drawer will slide out.

Figure 6-3  Opening drawer

2 Remove the drawer.

3 Remove the battery from the drawer (Figure 6-4 on page 107).

4 Replace a new 9-volt battery into the drawer, making sure that it is in the 
correct orientation.

Markings in the drawer will guide you.
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Figure 6-4  Changing battery

5 Slide the drawer into the bracket until you feel a click.

6 Test the new battery.

See Testing the Battery and Alarm on page 105.

Periodic Maintenance

The following instrument components should be checked occasionally and 
cleaned as necessary. The frequency will depend on how often the instrument is 
run. Other components should be checked periodically for wear and replaced if 
necessary.

• Changing the Sheath Filter on page 108

• Changing the Bal Seal on page 110

• Changing the Sample Tube O-Ring on page 112
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Changing the Sheath Filter

The sheath filter (Figure 6-5), connected to the top of the sheath container, filters 
the sheath fluid as it comes from the sheath container. Increased debris appearing 
in an FSC vs SSC plot can indicate that the sheath filter needs to be replaced. We 
recommend changing the sheath filter assembly every 3–6 months.

Figure 6-5  Sheath filter

Tip     To avoid spraying sheath fluid, depressurize the sheath container before 
opening it.

vent cap

quick-disconnect

quick-disconnect

vent line

cytometer fluid line

sheath container fluid line
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Remove the Old Filter

1 Place the instrument in STNDBY.

2 Disconnect the air line (green).

3 Depressurize the sheath container by lifting the vent valve.

For a description of the vent valve, see Figure 2-3 on page 44.

4 Detach the cytometer fluid line from the filter assembly by squeezing the 
quick-disconnect.

5 Detach the sheath container fluid line from the filter assembly by squeezing 
the quick-disconnect.

6 Remove the vent line from the filter; set aside.

Twist to remove.

7 Discard the used filter assembly.

Attach the New Filter

1 Connect the vent line to the filter. Twist to attach.

2 Connect the sheath container fluid line to the filter assembly via the quick-
disconnect.

3 Attach the cytometer fluid line to the filter assembly via the quick-
disconnect.

4 Turn on the instrument to pressurize the sheath container.

5 Loosen the filter’s vent cap to bleed off any air in the sheath filter.

6 Carefully tap the filter assembly to dislodge any air trapped in the filter 
element.

7 Loosen the filter’s vent cap again to bleed off any air in the sheath filter.
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Changing the Bal Seal

The sample injection tube Bal seal is a Teflon ring that forms a seal with the 
sample tube and ensures proper tube pressurization. Over time, this seal becomes 
worn or cracked and requires replacement. Replacement is necessary if a proper 
seal is not formed when a sample tube is installed on the SIP.

Tip     Indications that a proper seal has not formed include:

• the tube will not stay on the SIP without the tube support arm

• the tube is installed, RUN is pressed on the cytometer, and the RUN button 
is orange (not green)

To replace the Bal seal:

1 Remove the outer droplet sleeve from the sample injection tube by turning 
the retainer counterclockwise.

Figure 6-6  Removing the outer sleeve

Tip     Work carefully—the outer sleeve can fall out as you loosen the 
retainer.

Bal seal
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2 Remove the Bal seal by gripping it between your thumb and index finger 
and pulling (Figure 6-7).

Figure 6-7  Removing the Bal seal

3 Install the new Bal seal spring-side up.

Gently push the seal in place to seat it.

4 Reinstall the retainer and outer sleeve over the sample injection tube.

Tighten the retainer just enough to hold it in place.

5 Install a sample tube on the SIP to ensure that the outer sleeve has been 
properly installed.

If the sleeve hits the bottom of the tube, loosen the retainer slightly and 
push the sleeve up as far as it will go. Tighten the retainer.
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Changing the Sample Tube O-Ring

The sample tube O-ring, located within the retainer, forms a seal that allows the 
droplet containment vacuum to function properly. Replace the O-ring when 
droplets form at the end of the sample injection tube while the vacuum is 
operating.

1 Remove the outer droplet sleeve from the sample injection tube.

Turn the retainer counterclockwise and pull the outer sleeve from the 
retainer (Figure 6-6 on page 110).

2 Invert the retainer and allow the O-ring to fall onto the benchtop.

If the O-ring does not fall out initially, tap the retainer on the benchtop to 
dislodge the O-ring.

3 Drop the new O-ring into the retainer.

Make sure the O-ring is seated properly in the bottom of the retainer.

4 Reinstall the retainer and the outer sleeve.

5 Install a sample tube on the SIP to ensure that the outer sleeve has been 
properly installed.

If the sleeve hits the bottom of the tube, loosen the retainer slightly and 
push the sleeve up as far as it will go. Tighten the retainer.

Instrument hardware might be contaminated with biohazardous material. 
Wear suitable protective clothing, eyewear, and gloves whenever cleaning 
the instrument or replacing parts.
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7

Troubleshooting

The tips in this section are designed to help you troubleshoot your experiments. 
You can find additional troubleshooting information in the BD FACSDiva 
Software Reference Manual.

If additional assistance is required, contact your local BD Biosciences technical 
support representative. See Technical Assistance on page xv.
113



LSR2.book  Page 114  Tuesday, April 25, 2006  3:34 PM
Instrument Troubleshooting

Observation Possible Causes Recommended Solutions

Droplet containment 
vacuum not functioning

Worn O-ring in retainer Replace the O-ring. See Changing 
the Sample Tube O-Ring on 
page 112.

Outer sleeve not seated in the 
retainer

1 Loosen the retainer (Figure 6-6 
on page 110).

2 Push the outer sleeve up into 
the retainer until seated.

3 Tighten the retainer.

Outer sleeve not on the 
sample injection tube

Replace the outer sleeve.

1 Loosen the retainer.

2 Slide the outer sleeve over the 
sample injection tube until it is 
seated.

3 Tighten the retainer.

Waste line pinched, 
preventing proper aspiration

Check the waste line.

Waste tank full Empty the waste tank.

Sample tube not fitting 
on SIP

Sample tube other than 
BD Falcon tubes used

Use BD Falcon 12 x 75-mm 
sample tubes. See Equipment on 
page 152.

Worn Bal seal Replace the Bal seal. See Changing 
the Bal Seal on page 110.

Rapid sample aspiration Support arm to the side Place the support arm under the 
sample tube.

Droplet containment module 
failing

Call your service representative.
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No events in acquisition 
display and green RUN 
button

Threshold not set to correct 
parameter (usually FSC)

Set the threshold to the correct 
parameter for your application.

Threshold level too high Lower the threshold level. 

PMT voltage for threshold 
parameter set too low

Set the PMT voltage higher for the 
threshold parameter. 

Gating issue Refer to the BD FACSDiva 
Software Reference Manual for 
information on setting gates.

Air in sheath filter Purge the filter. See Removing Air 
Bubbles on page 47.

No sample in tube Add sample to tube or install new 
sample tube.

Sample not mixed properly Mix sample to suspend cells.

Waste tank full Empty the waste tank.

PMT voltages set too low or 
too high for display 
parameter

Reset PMT voltages.

Too few events displayed Increase the number of events to 
display.

Sample injection tube clogged Remove the sample tube to allow 
backflushing; then run a tube of 
warm DI water for 20 minutes.

If the event rate is still erratic, 
clean the sample injection tube. 
See Daily Cleaning and Shutdown 
on page 100.

Bal seal worn Replace the Bal seal. See Changing 
the Bal Seal on page 110.

Instrument Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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No events in acquisition 
display and green RUN 
button (continued)

Laser not warmed up Wait the recommended amount of 
time for the laser to warm up.

• 30 min for the 488-nm (blue) 

• 30 min for the 355-nm (UV)

• 15 min for the 405-nm (violet)

• 20 min for the 633-nm (red)

Laser delay set incorrectly Adjust the laser delay settings.

See Setting Laser Delay on 
page 193.

Laser not functioning Verify malfunction by changing 
the threshold to an alternative 
laser while running appropriate 
QC particles. If not successful, 
contact BD Biosciences.

No events in acquisition 
display and orange RUN 
button

RUN not activated Press the RUN button.

Sample tube not installed or 
not properly seated

Install the sample tube correctly 
on the SIP.

Sample tube cracked Replace the sample tube.

Sheath container not 
pressurized

• Ensure that the sheath 
container lid and all connectors 
are securely seated.

• Inspect the O-ring and replace 
if necessary. See Changing the 
Sample Tube O-Ring on 
page 112.

Bal seal worn Replace the Bal seal. See Changing 
the Bal Seal on page 110.

Air leak at sheath container Ensure that the sheath container 
lid and all connectors are securely 
seated.

Instrument Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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No events in acquisition 
display and orange RUN 
button (continued)

Sheath container empty Fill the sheath container.

Air in sheath filter Purge the filter. See Removing Air 
Bubbles on page 47.

No fluorescent signal Incorrect fluorochrome 
assignment

Make sure the instrument 
configuration in the software 
matches the optical filters in the 
instrument.

Wrong filter installed Make sure the appropriate filter is 
installed for each fluorochrome. 
See Changing Optical Filters or 
Mirrors on page 42.

Laser not functioning Verify laser malfunction by 
changing the threshold to an 
alternative laser while running 
appropriate QC particles. If not 
successful, contact 
BD Biosciences.

Instrument Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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High event rate Air bubble in sheath filter or 
flow cell

Remove the air bubble. See 
Removing Air Bubbles on 
page 47.

Threshold level too low Increase the threshold level. Refer 
to the BD FACSDiva Software 
Reference Manual for 
instructions.

PMT voltage for threshold 
parameter set too high

Set the PMT voltage lower for the 
threshold parameter. Refer to the 
BD FACSDiva Software 
Reference Manual for 
instructions.

Sample too concentrated Dilute the sample.

Sample flow rate set on HI Set the sample flow rate to MED 
or LO.

Instrument Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Low event rate Threshold level too high Lower the threshold level. Refer to 
the BD FACSDiva Software 
Reference Manual for 
instructions.

PMT voltage for threshold 
parameter set too low

Set the PMT voltage higher for the 
threshold parameter. Refer to the 
BD FACSDiva Software 
Reference Manual for 
instructions.

Sample not adequately mixed Mix the sample to suspend cells.

Sample too dilute Concentrate the sample. If the 
flow rate setting is not critical to 
the application, set the flow rate 
switch to MED or HI.

Sample injection tube clogged Remove the sample tube to allow 
backflushing; then run a tube of 
warm DI water for 20 minutes.

If the event rate is still erratic, 
clean the sample injection tube. 
See Daily Cleaning and Shutdown 
on page 100.

Erratic event rate Sample tube cracked Replace the sample tube.

Bal seal worn Replace the Bal seal. See Changing 
the Bal Seal on page 110.

Sample injection tube clogged Remove the sample tube to allow 
backflushing; then run a tube of 
warm DI water for 20 minutes.

If the event rate is still erratic, 
clean the sample injection tube. 
See Daily Cleaning and Shutdown 
on page 100.

Instrument Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Erratic event rate 
(continued)

Sample injection tube clogged Remove the sample tube to allow 
backflushing; then run a tube of 
warm DI water for 20 minutes.

If the event rate is still erratic, 
clean the sample injection tube. 
See Daily Cleaning and Shutdown 
on page 100.

Contaminated sample Prepare the specimen again. 
Ensure that the tube is clean.

Worn sheath filter Replace the filter. See Changing 
the Sheath Filter on page 108.

Distorted scatter 
parameters

Instrument settings 
maladjusted

Optimize the scatter parameters. 
Refer to the BD FACSDiva 
Software Reference Manual for 
instructions.

Air bubble in sheath filter or 
flow cell

Purge the air from the filter. See 
Removing Air Bubbles on 
page 47.

Flow cell dirty Perform the system flush 
procedure. See System Flush on 
page 103.

Air leak at sheath container Ensure that the sheath container 
lid is tight and all connectors are 
secure.

Hypertonic buffers or fixative Replace the buffers and fixative.

Instrument Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Excessive amount of 
debris in display

Threshold level too low Increase the threshold level.

Sheath filter dirty Replace the filter. See Changing 
the Sheath Filter on page 108.

Flow cell dirty Flush the system. See System Flush 
on page 103.

Dead cells or debris in sample Examine the sample under a 
microscope.

Sample contaminated Re-stain the sample, ensure tube is 
clean.

Stock sheath fluid 
contaminated

Rinse the sheath container with DI 
water; then fill with sheath fluid 
from another (or new lot) bulk 
container.

High CV Air bubble in sheath filter or 
flow cell

Purge the filter. See Removing Air 
Bubbles on page 47.

Sample flow rate set too high Set the sample flow rate lower.

Air leak at sheath container Ensure that the sheath container 
lid is tight and all connectors are 
secure.

Flow cell dirty Flush the system. See System Flush 
on page 103.

Poor sample preparation Repeat sample preparation.

Sample not diluted in same 
fluid as sheath fluid

Dilute the sample in the same fluid 
as you are using for sheath.

Old or contaminated quality 
control (QC) particles

Make new QC samples and 
perform the quality control 
procedure again.

Instrument Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Poor QC results Air bubble or debris in flow 
cell

Prime the fluidics system. See 
Priming the Fluidics on page 49.

Old or contaminated QC 
particles

Make new QC samples and 
perform the quality control 
procedure again.

Sample not diluted in same 
fluid as sheath fluid

Dilute the sample in the same fluid 
as you are using for sheath. If you 
are running BD CaliBRITE™ 
beads, dilute them in 
BD FACSFlow solution and use 
BD FACSFlow solution for sheath 
fluid.

Laser not warmed up Wait the recommended amount of 
time for the laser to warm up.

• 30 min for the 488-nm (blue) 

• 30 min for the 355-nm (UV)

• 15 min for the 405-nm (violet)

• 20 min for the 633-nm (red)

Laser not functioning Contact BD Biosciences.

Optical alignment problem Contact BD Biosciences.

Instrument Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Appendix A

Technical Overview

This appendix contains a technical overview of the following topics:

• Fluidics on page 124

• Optics on page 125

• Electronics on page 134
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Fluidics

The fluidics system in the BD LSR II flow cytometer is pressure driven—a built-in 
air pump provides a sheath pressure of 5.5 psi. After passing through the sheath 
filter, sheath fluid is introduced into the lower chamber of the quartz flow cell.

The sample to be analyzed arrives in a separate pressurized stream. When a 
sample tube is placed on the sample injection port (SIP), the sample is forced up 
and injected into the lower chamber of the flow cell by a slight overpressure 
relative to the sheath fluid. The conical shape of the lower chamber creates a 
laminar sheath flow that carries the sample core upward through the center of 
the flow cell, where the particles to be measured are intercepted by the laser beam 
(Figure A-1 on page 125). This process is known as hydrodynamic focusing.

The objective in flow cytometric analysis is to have at most one cell or particle 
moving through a laser beam at a given time. The difference in pressure between 
the sample stream and sheath fluid stream can be used to vary the diameter of the 
sample core. Increasing the sample pressure increases the core diameter and 
therefore the flow rate (Figure A-1 on page 125).

• A higher flow rate is generally used for qualitative measurements such as 
immunophenotyping. The data is less resolved but is acquired more 
quickly.

• A lower flow rate is generally used in applications where greater resolution 
and quantitative measurements are critical, such as DNA analysis.

Proper operation of fluidic components is critical for particles to intercept the 
laser beam properly. Always ensure that the fluidics system is free of air bubbles 
and debris and is properly pressurized.
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Figure A-1  Hydrodynamic focusing of the sample core through the flow cell

Optics

The optics system consists of lasers, optical filters, and detectors. Lasers 
illuminate the cells or particles in the sample and optical filters direct the 
resulting light scatter and fluorescence signals to the appropriate detectors.

Light Scatter

When a cell or particle passes through a focused laser beam, laser light is 
scattered in all directions (Figure A-2 on page 126). Light that scatters axial to 
the laser beam is called forward scatter (FSC); light that scatters perpendicular to 
the laser beam is called side scatter (SSC). FSC and SSC are related to certain 
physical properties of cells:

• FSC—indicates relative differences in the size of the cells or particles

• SSC—indicates relative differences in the internal complexity or granularity 
of the cells or particles
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Figure A-2  Forward scatter (FSC) and side scatter (SSC)

Fluorescence

When cells or particles stained with fluorochrome-conjugated antibodies or other 
dyes pass through a laser beam, the dyes can absorb photons (energy) and be 
promoted to an excited electronic state. In returning to their ground state, the 
dyes release energy, most of which is emitted as light. This light emission is 
known as fluorescence.

Fluorescence is always a longer wavelength (lower-energy photon) than the 
excitation wavelength. The difference between the excitation wavelength and the 
emission wavelength is known as the Stokes shift. Some fluorescent compounds 
such as PerCP exhibit a large Stokes shift, absorbing blue light (488 nm) and 
emitting red light (675 nm), while other fluorochromes such as FITC have a 
smaller Stokes shift, absorbing blue light and emitting green light (530 nm).

The emission spectra for some commonly used fluorochromes are shown in 
Figure A-3 on page 127.

light source

side scatter

forward scatter
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Figure A-3  Emission spectra of commonly used fluorochromes 

Optical Filters

Optical filters modify the spectral distribution of light scatter and fluorescence   
directed to the detectors. When photons encounter an optical filter, they are 
either transmitted, absorbed, or reflected (Figure A-4).

Figure A-4  Effect of an optical filter on incident photons
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Even though an optical filter is rated at its 50% transmission point, the filter 
passes—or lets through—a minimal amount of light outside of this indicated 
rating.

The slope of an optical filter transmission curve indicates filter performance. A 
relatively steep slope indicates a high-performance, high-quality optical filter that 
provides deep attenuation of out-of-band wavelengths. A less steep slope 
indicates that more light outside the rated bandwidth is being transmitted.

Two kinds of filters are used on the BD LSR II flow cytometer:

• longpass (LP)

• bandpass (BP), including discriminating filters (DF) and ALPHA filters 
(AF)

A third filter type, the shortpass (SP), is not recommended, but can be used in 
some custom configurations. See Shortpass Filter on page 129.

LP, BP, and SP filters are referred to as dichroic filters. See Dichroic Mirrors on 
page 131.

Longpass Filter 

LP filters pass wavelengths longer than the filter rating. For example, a 500-LP 
filter permits wavelengths longer than 500 nm to pass through it and either 
absorbs or reflects wavelengths shorter than 500 nm.
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Shortpass Filter

An SP filter has the opposite properties of a longpass filter. An SP filter passes 
light with a shorter wavelength than the filter rating.

Bandpass Filter 

A BP filter transmits a relatively narrow range or band of light. Bandpass filters 
are typically designated by two numbers. The first number indicates the center 
wavelength and the second refers to the width of the band of light that is passed. 
For example, a 500/50 BP filter transmits light that is centered at 500 nm and has 
a total bandwidth of 50 nm. Therefore, this filter transmits light between 475 
and 525 nm (Figure A-5 on page 130).
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Figure A-5  Bandpass filter

BP and DF filters have the same general function—they transmit a relatively 
narrow band of light. The principal difference between them is their 
construction. DF filters have more cavities or layers of optical coatings, resulting 
in a steeper transmission curve than the curve for a BP filter. This steep slope 
means that a DF filter is better at blocking light outside the rated bandwidth of 
the filter. 
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Dichroic Mirrors

Dichroic filters that are used to direct different color light signals to different 
detectors are called dichroic mirrors or beam splitters.

Although dichroic mirrors have the properties of LP or SP optical filters, you can 
not necessarily use any type of LP or SP filter as a beam splitter. A beam splitter 
must have a surface coating that reflects certain wavelengths, but many LP or SP 
filters are absorbance filters that do not have any specific reflective 
characteristics. Also, optical filters and beam splitters are rated at a specific angle 
of incidence. When used in front of the fluorescence detectors, they are 
perpendicular to the incident light, and when used as a beam splitter, they are 
placed at an angle relative to the light source. Their optical properties are 
therefore designed for that angle of incidence.

Compensation Theory

Fluorochromes emit light over a range of wavelengths (Figure A-3 on page 127). 
Optical filters are used to limit the range of frequencies measured by a given 
detector. However, when two or more fluorochromes are used, the overlap in 
wavelength ranges often makes it impossible for optical filters to isolate light 
from a given fluorochrome. As a result, light emitted from one fluorochrome 
appears in a detector intended for another (Figure A-6). This is referred to as 
spillover. Spillover can be corrected mathematically by using a method called 
compensation.
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Figure A-6  Spillover from the FITC fluorochrome to the PE detector

For example, FITC emission appears primarily in the FITC detector, but some of 
its fluorescence spills over into the PE detector. The spillover is corrected or 
compensated for: hence the term fluorescence compensation.

Figure A-6 shows that some of the FITC emission appears in the PE detector. This 
can be seen in a dot plot of FITC vs PE (Figure A-7).

Figure A-7  Theoretical display of FITC vs PE without compensation

This FITC spillover in the PE detector is to be corrected as indicated by the arrow 
in Figure A-7. Using the Compensation tab of the Instrument window in 
BD FACSDiva software, adjust the PE-%FITC spectral overlap value. 
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Compensation is optimal when the positive and negative FITC populations have 
the same means or medians in the PE parameter statistics (Figure A-8).

Figure A-8  FITC spillover optimally compensated out of the PE parameter

Once fluorescence compensation has been set for any sample, the compensation 
setting remains valid for a subsequent dim or bright sample, because 
compensation subtracts a percentage of the fluorescence intensity. Figure A-9 
illustrates this principle. Although the signals differ in intensity, the percentage of 
the FITC spillover into the PE detector remains constant.

Figure A-9  Two FITC signals of different intensity
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Electronics

As cells or other particles pass through a focused laser beam, they scatter the 
laser light and can emit fluorescence. Because the laser beam is focused on a small 
spot and particles move rapidly through the flow cell, the scatter or fluorescence 
emission has a very brief duration—only a few microseconds. This brief flash of 
light is converted into an electrical signal by the detectors. The electrical signal is 
called a pulse (Figure A-10).

1 A pulse begins when a particle enters the laser beam. At this point, both the 
beam intensity and signal intensity are low.

2 The pulse reaches a maximum intensity or height when the particle reaches 
the middle of the beam, where the beam and signal intensity are the 
brightest. The peak intensity, or height of the pulse, is measured at this 
point.

3 As the particle leaves the beam, the pulse trails off below the threshold.

Figure A-10  Anatomy of a pulse
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Pulse Measurements

The pulse processors measure pulses by three characteristics: height, area, and 
width (Figure A-11).

Figure A-11  Pulse measurements

• pulse height is the maximum digitized intensity measured for the pulse

• pulse area is an integration of the digitized measures over time

• pulse width calculates: 
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Digital Electronics

BD LSR II flow cytometer electronics digitize the signal intensity produced by a 
detector. The digitized data is stored in memory and further processed by the 
electronics to calculate

• pulse height, area, and width

• compensation

• parameter ratios

These results are transferred to your workstation computer for further processing 
by BD FACSDiva software. For more information about digital theory, refer to 
Digital Theory in the BD FACSDiva Software Reference Manual. 

BD FACSDiva Option White Paper

For an in-depth discussion of digital electronics, visit our website at
bdbiosciences.com/immunocytometry_systems/ and download the BD FACSDiva 
Option White Paper. 

If you have difficulty downloading this white paper from the web, contact your 
local BD Biosciences technical support representative or supplier for updated 
instructions (see Technical Assistance on page xv).
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Threshold

The threshold is the level at which the system starts to measure signal pulses. A 
threshold is defined for a specific detector signal. The system continuously 
samples the digitized signal data and calculates pulse area, height, and width for 
all channels based on the time interval during which the threshold is exceeded.

Thresholds can also be set for more than one parameter, and pulse measures are 
based on either of the following:

• intervals during which ALL signals exceed their threshold value

• intervals during which ANY signal exceeds its threshold value

Laser Controls

Controls in the Laser tab of the Instrument window are used to set the (laser) 
delay, area scaling, and window extension values.

These parameters are set by BD Biosciences service personnel when the 
BD LSR II flow cytometer is installed, and they rarely need to be changed. 
Record and save these parameter values for future reference.

If needed, see Appendix G for instructions on optimizing laser delay settings. Do 
not otherwise change the settings in the Laser tab unless instructed to do so by 
BD Biosciences. Changing the settings will affect your data.
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Appendix B

BD LSR II QC Log

This sample quality control (QC) log can be photocopied or used as a guide in 
designing your own QC log.
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Appendix C

Filter Templates

You can use these templates to note your custom filter configurations for the 
BD LSR II instrument.

• Octagon Template on page 145

• Trigon Template on page 147
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Octagon Template

Laser____________________ Experiment_____________________
Appendix C: Filter Templates 145
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Trigon Template

Laser____________________ Experiment_____________________
Appendix C: Filter Templates 147
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Appendix D

Supplies and Consumables

To order spare parts and consumables, such as bulk fluids, from BD Biosciences:

• within the US, call: (877) 232-8995.

• outside the US, contact your local BD Biosciences customer service 
representative.

Worldwide contact information can be found at bdbiosciences.com.

Use the following part numbers to order supplies for your BD LSR II system:

• QC Particles on page 150

• Reagents on page 151

• Equipment on page 152
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QC Particles

Particle Laser Supplier Catalog No.

• BD Calibrite 3 beads
(unlabeled, FITC, 
PE, PerCP)

• BD Calibrite APC 
beads

• blue 488 nm

• red 633 nm

BD Biosciences • 340486

• 340487

• SPHERO™ 
Rainbow 
Calibration Particles
(8 peak)

• SPHERO Ultra 
Rainbow 
Fluorescent Particles 
(single peak)

• all

• all

• BD Biosciences

• Spherotech, Inc.

• 559123

• URFP-
30-2

DNA QC Particles kit blue 488 nm BD Biosciences 349523
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Reagents

Reagent Supplier Catalog No.

BD FACSFlow sheath fluid BD Biosciences 340398
(US and Latin 

America)

342003
(Europe)

Monoclonal antibodies BD Biosciences –a

a. Refer to the BD Biosciences Product Catalog or the BD Biosciences website 
(bdbiosciences.com).

BD FACS™ lysing solution BD Biosciences 349202

BD FACSRinse solution BD Biosciences 340346

BD FACSClean solution BD Biosciences 340345

Dyes and fluorochromes BD Biosciences

Molecular Probes

Sigma

–

Chlorine bleach (5% sodium 
hypochlorite)

Clorox or other major 
supplier (to ensure that 
the bleach is at the 
correct concentration 
and free of particulate 
matter)

–
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Equipment

Equipment Item Supplier Catalog No.

Bal seal BD Biosciences 343509

O-ring, sample tube 343615

Sheath filter assembly 344678

BD Falcon polystyrene test tubes, 
12 x 75-mm 

BD Labware  352052
352054
352058
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Appendix E

Standard Default Configuration

The standard default configuration for a BD LSR II cytometer supports detectors, 
filters, and mirrors for one to four lasers. This appendix describes how to set up 
the instrument optics using standard default configuration components.

• Standard (4-Blue 2-Violet 2-UV 2-Red) Configuration Specification on 
page 154

• Custom Configurations on page 159

The BD LSR II cytometer can also be ordered with one of several optional 
configurations, which are described in Appendix F.
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Standard (4-Blue 2-Violet 2-UV 2-Red) 
Configuration Specification

The standard configuration supports a blue octagon, and violet, UV, and red 
trigons. Table E-1 shows the detectors, filters, and mirrors used in the standard 
default configuration, and recommended fluorochromes per detector. The word 
“blank” indicates that a blank optical holder should be used instead of a mirror 
or filter. A dash (—) indicates that no slot exists for a mirror in that PMT 
position. 

Table E-1  Default filters and fluorochromes

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter

blue octagon 
(488-nm laser)

A 735 LP 780/60 PE-Cy7

B 685 LP 695/40 PerCP-Cy5.5

C 550 LP 575/26 PE, PI

D 505 LP 530/30 FITC, GFP

E blank 488/10 SSC

F blank blank none

G blank blank none

H — blank none

violet trigon 
(405-nm laser)

A 505 LP 525/50 AmCyan

B blank 440/40 Pacific Blue™

C — blank none

UV trigon 
(355-nm laser)

A 505 LP 530/30 Indo-1 (Blue)

B blank 450/50 Indo-1 (Violet), DAPI

C — blank none
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Default Configuration

Figure E-1 shows the standard default instrument configuration.

Figure E-1  Default configuration

red trigon 
(633-nm laser)

A 735 LP 780/60 APC-Cy7

B blank 660/20 APC

C — blank none

Table E-1  Default filters and fluorochromes (continued)

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter
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Octagon and Trigon Maps

This section shows how to install mirrors and filters in your octagon and trigons 
for the standard default configuration. 

If a slot is filled with a filter or mirror, an identifying number appears in that 
position on the configuration map. If a slot is filled with a blank optical holder, 
that position on the configuration map is unlabeled.

Figure E-2  Standard default configuration: blue octagon
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530/30
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780/60
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575/26

550 LP
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PerCP-Cy5.5

488-nm blue laser
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Figure E-3  Standard default configuration: red and violet trigons 
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735 LP
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525/50
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AmCyan
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Figure E-4  Standard default configuration: UV trigon 
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Custom Configurations

This section describes some common custom filter and mirror configurations. 
Table E-2 shows the detector arrays, mirrors, and filters used in the custom 
configurations, and recommended fluorochromes per detector. The mirrors and 
filters used in these custom configurations are contained in the BD LSR II 
instrument spares kit.

Maps on the following pages show how to install mirrors and filters in your 
octagon and trigons for common custom configurations.

Table E-2  Spare filters and fluorochromes

Detector Array (Laser) Mirror Filter Fluorochrome

blue octagon 
standard 488-nm blue laser

600 LP 610/20 PE-Texas Red™

635 LP 670/14 PerCP 
BD Cy-Chrome™ reagent

585/42 DsRed

violet trigon
optional 405-nm violet laser 

none none none

UV trigon 
optional 355-nm UV laser

450 LP Indo-1 (Blue)

405/20 Indo-1 (Violet)

red trigon 
optional 633-nm red laser

none none none
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PE-Texas Red™

To use PE-Texas Red™, replace the mirror and filter for the B PMT of the blue 
octagon as shown below.

48
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10

530/30

505 LP

FITC

SS
C

610/20

600 LP

780/60

735 LP

575/26

550 LP

PE-Cy7
PE

PE-Texas Red

488-nm blue laser
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Indo-1

If you have a violet laser, replace the mirror for the A PMT of the UV trigon as 
shown on the left below. 

If you do not have a violet laser, replace both the mirror for the A PMT and the 
filter for the B PMT of the UV trigon as shown on the right below. 

 

450/50

530/30

450 LP

Indo-1 (Blue)

Indo-1 (Violet)

405/20

530/30

450 LP

Indo-1 (Blue)

Indo-1 (Violet)

355-nm UV laser
(with violet laser)

355-nm UV laser
(no violet laser)
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DsRed

To use DsRed, replace the filter for the C PMT of the blue octagon as shown 
below.

48
8/

10

530/30

505 LP

FITC

SS
C

695/40

685 LP

780/60

735 LP

585/42

550 LP

PE-Cy7DsRed

PerCP-Cy5.5

488-nm blue laser
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PerCP or BD Cy-Chrome Reagent

To use PerCP or BD Cy-Chrome reagent, replace the mirror and filter for the B 
PMT of the blue octagon as shown below.

48
8/

10

530/30

505 LP

FITC

SS
C

670/14

635 LP

780/60

735 LP

575/26

550 LP

PE-Cy7
PE

PerCP

488-nm blue laser
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Appendix F

Special Order Configurations

The BD LSR II cytometer can be ordered with, or upgraded to one of several 
laser and detector array options. If you upgrade your configuration, you must use 
BD FACS Instrument Configuration Application (ICA) to update your 
BD FACSDiva software default instrument configuration (database object). 

This appendix contains the following information:

• Common Special Order Configurations on page 166

• Special Order Configuration Trigon and Octagon Maps on page 180

• BD FACS Instrument Configuration Application on page 187
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Common Special Order Configurations

The following are commonly used configurations.

• 6-Blue 0-Violet 0-UV 3-Red Configuration on page 167

• 6-Blue 2-Violet 0-UV 3-Red Configuration on page 168

• 6-Blue 0-Violet 2-UV 3-Red Configuration on page 169

• 6-Blue 2-Violet 2-UV 3-Red Configuration on page 171

• 6-Blue 6-Violet 0-UV 3-Red Configuration on page 172

• 6-Blue 6-Violet 0-UV 4-Red Configuration on page 174

• 6-Blue 6-Violet 2-UV 3-Red Configuration on page 176

• 6-Blue 6-Violet 2-UV 4-Red Configuration on page 178
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6-Blue 0-Violet 0-UV 3-Red Configuration

6-Blue 0-Violet 0-UV 3-Red supports a blue octagon, and a red trigon. Table F-1 
shows the detectors, filters, and mirrors used in the default configuration. The 
word “blank” indicates that a blank optical holder should be used instead of a 
mirror or filter. A dash (—) indicates that no slot exists for a mirror in that PMT 
position.

The 6-Blue 0-Violet 0-UV 3-Red maps are:

• 6-Color Blue Octagon Default Configuration Map on page 181

• 3-Color Red Trigon Default Configuration Map on page 185

Table F-1  6-Blue 0-Violet 0-UV 3-Red default mirror and filter configuration

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter

blue octagon 
(488-nm laser)

A 755 LP 780/60 PE-Cy7

B 685 LP 695/40 PerCP-Cy5.5

C 655 LP 660/20 PE-Cy5

D 600 LP 610/20 PE-Texas Red™

E 550 LP 575/26 PE

F 505 LP 530/30 FITC, Alexa Fluor® 488

G blank 488/10 SSC

H — blank none

red trigon 
(633-nm laser)

A 755 LP 780/60 APC-Cy7

B 710 LP 730/45 Alexa Fluor® 700

C — 660/20 APC
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6-Blue 2-Violet 0-UV 3-Red Configuration

6-Blue 2-Violet 0-UV 3-Red supports a blue octagon, and violet and red trigons. 
Table F-2 shows the detectors, filters, and mirrors used in the default 
configuration. The word “blank” indicates that a blank optical holder should be 
used instead of a mirror or filter. A dash (—) indicates that no slot exists for a 
mirror in that PMT position.

The 6-Blue 2-Violet 0-UV 3-Red maps are:

• 6-Color Blue Octagon Default Configuration Map on page 181

• 2-Color Violet Trigon Default Configuration Map on page 182

• 3-Color Red Trigon Default Configuration Map on page 185

 

Table F-2  6-Blue 2-Violet 0-UV 3-Red default mirror and filter configuration

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter

blue octagon 
(488-nm laser)

A 755 LP 780/60 PE-Cy7

B 685 LP 695/40 PerCP-Cy5.5

C 655 LP 660/20 PE-Cy5

D 600 LP 610/20 PE-Texas Red™

E 550 LP 575/26 PE

F 505 LP 530/30 FITC, Alexa Fluor® 488

G blank 488/10 SSC

H — blank none
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6-Blue 0-Violet 2-UV 3-Red Configuration

6-Blue 0-Violet 2-UV 3-Red supports a blue octagon, and UV and red trigons. 
Table F-3 on page 170 shows the detectors, filters, and mirrors used in the 
default configuration. The word “blank” indicates that a blank optical holder 
should be used instead of a mirror or filter. A dash (—) indicates that no slot 
exists for a mirror in that PMT position.

The 6-Blue 0-Violet 2-UV 3-Red maps are:

• 6-Color Blue Octagon Default Configuration Map on page 181

• 2-Color UV Trigon Default Configuration Map on page 184

• 3-Color Red Trigon Default Configuration Map on page 185

violet trigon 
(405-nm laser)

A 505 LP 525/50 AmCyan

B blank 450/50 Pacific Blue™

C — blank none

red trigon 
(633-nm laser)

A 755 LP 780/60 APC-Cy7

B 710 LP 730/45 Alexa Fluor® 700

C — 660/20 APC

Table F-2  6-Blue 2-Violet 0-UV 3-Red default mirror and filter configuration (continued)

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter
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Table F-3  6-Blue 0-Violet 2-UV 3-Red default mirror and filter configuration

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter

blue octagon 
(488-nm laser)

A 755 LP 780/60 PE-Cy7

B 685 LP 695/40 PerCP-Cy5.5

C 655 LP 660/20 PE-Cy5

D 600 LP 610/20 PE-Texas Red™

E 550 LP 575/26 PE

F 505 LP 530/30 FITC, Alexa Fluor® 488

G blank 488/10 SSC

H — blank none

UV trigon 
(355-nm laser)

A 505 LP 530/30 Indo-1 (Blue)

B blank 450/50 Indo-1 (Violet), DAPI

C — blank none

red trigon 
(633-nm laser)

A 755 LP 780/60 APC-Cy7

B 710 LP 730/45 Alexa Fluor® 700

C — 660/20 APC
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6-Blue 2-Violet 2-UV 3-Red Configuration

6-Blue 2-Violet 2-UV 3-Red supports a blue octagon, and violet, UV, and red 
trigons. Table F-4 shows the detectors, filters, and mirrors used in the default 
configuration. The word “blank” indicates that a blank optical holder should be 
used instead of a mirror or filter. A dash (—) indicates that no slot exists for a 
mirror in that PMT position.

The 6-Blue 2-Violet 2-UV 3-Red maps are:

• 6-Color Blue Octagon Default Configuration Map on page 181

• 2-Color Violet Trigon Default Configuration Map on page 182

• 2-Color UV Trigon Default Configuration Map on page 184

• 3-Color Red Trigon Default Configuration Map on page 185

Table F-4  6-Blue 2-Violet 2-UV 3-Red default mirror and filter configuration

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter

blue octagon 
(488-nm laser)

A 755 LP 780/60 PE-Cy7

B 685 LP 695/40 PerCP-Cy5.5

C 655 LP 660/20 PE-Cy5

D 600 LP 610/20 PE-Texas Red™

E 550 LP 575/26 PE

F 505 LP 530/30 FITC, Alexa Fluor® 488

G blank 488/10 SSC

H — blank none
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6-Blue 6-Violet 0-UV 3-Red Configuration

6-Blue 6-Violet 0-UV 3-Red supports blue violet octagons, and a red trigon. 
Table F-5 on page 173 shows the detectors, filters, and mirrors used in the 
default configuration. The word “blank” indicates that a blank optical holder 
should be used instead of a mirror or filter. A dash (—) indicates that no slot 
exists for a mirror in that PMT position.

The 6-Blue 6-Violet 0-UV 3-Red maps are:

• 6-Color Blue Octagon Default Configuration Map on page 181

• 6-Color Violet Octagon Default Configuration Map on page 183

• 3-Color Red Trigon Default Configuration Map on page 185

violet trigon 
(405-nm laser)

A 505 LP 525/50 AmCyan

B blank 450/50 Pacific Blue™

C — blank none

UV trigon 
(355-nm laser)

A 505 LP 530/30 Indo-1 (Blue)

B blank 450/50 Indo-1 (Violet), DAPI

C — blank none

red trigon 
(633-nm laser)

A 755 LP 780/60 APC-Cy7

B 710 LP 730/45 Alexa Fluor® 700

C — 660/20 APC

Table F-4  6-Blue 2-Violet 2-UV 3-Red default mirror and filter configuration (continued)

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter
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Table F-5  6-Blue 6-Violet 0-UV 3-Red default mirror and filter configuration

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter

blue octagon 
(488-nm laser)

A 755 LP 780/60 PE-Cy7

B 685 LP 695/40 PerCP-Cy5.5

C 655 LP 660/20 PE-Cy5

D 600 LP 610/20 PE-Texas Red™

E 550 LP 575/26 PE

F 505 LP 530/30 FITC, Alexa Fluor® 488

G blank 488/10 SSC

H — blank none

violet octagon 
(405-nm laser)

A 630 LP 655/8 Qdot 655

B 595 LP 605/12 Qdot 605

C 575 LP 585/15 Qdot 585

D 545 LP 560/20 Qdot 565

E 475 LP 525/50 AmCyan, Qdot 525

F blank 450/50 Pacific Blue™

G blank blank none

H — blank none

red trigon 
(633-nm laser)

A 755 LP 780/60 APC-Cy7

B 710 LP 730/45 Alexa Fluor® 700

C — 660/20 APC
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6-Blue 6-Violet 0-UV 4-Red Configuration

6-Blue 6-Violet 0-UV 4-Red supports blue, violet, and red octagons. Table F-6 
shows the detectors, filters, and mirrors used in the default configuration. The 
word “blank” indicates that a blank optical holder should be used instead of a 
mirror or filter. A dash (—) indicates that no slot exists for a mirror in that PMT 
position.

The 6-Blue 6-Violet 0-UV 4-Red maps are:

• 6-Color Blue Octagon Default Configuration Map on page 181

• 6-Color Violet Octagon Default Configuration Map on page 183

• 4-Color Red Octagon Default Configuration Map on page 186

Table F-6  6-Blue 6-Violet 0-UV 4-Red default mirror and filter configuration

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter

blue octagon 
(488-nm laser)

A 755 LP 780/60 PE-Cy7

B 685 LP 695/40 PerCP-Cy5.5

C 655 LP 660/20 PE-Cy5

D 600 LP 610/20 PE-Texas Red™

E 550 LP 575/26 PE

F 505 LP 530/30 FITC, Alexa Fluor® 488

G blank 488/10 SSC

H — blank none
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violet octagon 
(405-nm laser)

A 630 LP 655/8 Qdot 655

B 595 LP 605/12 Qdot 605

C 575 LP 585/15 Qdot 585

D 545 LP 560/20 Qdot 565

E 475 LP 525/50 AmCyan, Qdot 525

F blank 450/50 Pacific Blue™

G blank blank none

H — blank none

red octagon 
(633-nm laser)

A 755 LP 780/60 APC-Cy7

B 710 LP 730/45 Alexa Fluor® 700

C 675 LP 685/35 Alexa Fluor® 680

D — 660/20 APC

E blank blank none

F blank blank none

G blank blank none

H — blank none

Table F-6  6-Blue 6-Violet 0-UV 4-Red default mirror and filter configuration (continued)

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter
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6-Blue 6-Violet 2-UV 3-Red Configuration

6-Blue 6-Violet 2-UV 3-Red supports blue and violet octagons, and UV and red 
trigons. Table F-7 shows the detectors, filters, and mirrors used in the default 
configuration. The word “blank” indicates that a blank optical holder should be 
used instead of a mirror or filter. A dash (—) indicates that no slot exists for a 
mirror in that PMT position.

The 6-Blue 6-Violet 2-UV 3-Red maps are:

• 6-Color Blue Octagon Default Configuration Map on page 181

• 6-Color Violet Octagon Default Configuration Map on page 183

• 2-Color UV Trigon Default Configuration Map on page 184

• 3-Color Red Trigon Default Configuration Map on page 185

Table F-7  6-Blue 6-Violet 2-UV 3-Red default mirror and filter configuration

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter

blue octagon 
(488-nm laser)

A 755 LP 780/60 PE-Cy7

B 685 LP 695/40 PerCP-Cy5.5

C 655 LP 660/20 PE-Cy5

D 600 LP 610/20 PE-Texas Red™

E 550 LP 575/26 PE

F 505 LP 530/30 FITC, Alexa Fluor® 488

G blank 488/10 SSC

H — blank none
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violet octagon 
(405-nm laser)

A 630 LP 655/8 Qdot 655

B 595 LP 605/12 Qdot 605

C 575 LP 585/15 Qdot 585

D 545 LP 560/20 Qdot 565

E 475 LP 525/50 AmCyan, Qdot 525

F blank 450/50 Pacific Blue™

G blank blank none

H — blank none

UV trigon 
(355-nm laser)

A 505 LP 530/30 Indo-1 (Blue)

B blank 450/50 Indo-1 (Violet), DAPI

C — blank none

red trigon 
(633-nm laser)

A 755 LP 780/60 APC-Cy7

B 710 LP 730/45 Alexa Fluor® 700

C — 660/20 APC

Table F-7  6-Blue 6-Violet 2-UV 3-Red default mirror and filter configuration (continued)
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6-Blue 6-Violet 2-UV 4-Red Configuration

6-Blue 6-Violet 2-UV 4-Red supports blue, violet, and red octagons, and a UV 
trigon. Table F-8 shows the detectors, filters, and mirrors used in the default 
configuration. The word “blank” indicates that a blank optical holder should be 
used instead of a mirror or filter. A dash (—) indicates that no slot exists for a 
mirror in that PMT position.

The 6-Blue 6-Violet 2-UV 4-Red maps are:

• 6-Color Blue Octagon Default Configuration Map on page 181

• 6-Color Violet Octagon Default Configuration Map on page 183

• 2-Color UV Trigon Default Configuration Map on page 184

• 4-Color Red Octagon Default Configuration Map on page 186

Table F-8  6-Blue 6-Violet 2-UV 4-Red default mirror and filter configuration

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter

blue octagon 
(488-nm laser)

A 755 LP 780/60 PE-Cy7

B 685 LP 695/40 PerCP-Cy5.5

C 655 LP 660/20 PE-Cy5

D 600 LP 610/20 PE-Texas Red™

E 550 LP 575/26 PE

F 505 LP 530/30 FITC, Alexa Fluor® 488

G blank 488/10 SSC

H — blank none
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violet octagon 
(405-nm laser)

A 630 LP 655/8 Qdot 655

B 595 LP 605/12 Qdot 605

C 575 LP 585/15 Qdot 585

D 545 LP 560/20 Qdot 565

E 475 LP 525/50 AmCyan, Qdot 525

F blank 450/50 Pacific Blue™

G blank blank none

H — blank none

UV trigon 
(355-nm laser)

A 505 LP 530/30 Indo-1 (Blue)

B blank 450/50 Indo-1 (Violet), DAPI

C — blank none

red octagon 
(633-nm laser)

A 755 LP 780/60 APC-Cy7

B 710 LP 730/45 Alexa Fluor® 700

C 675 LP 685/35 Alexa Fluor® 680

D — 660/20 APC

E blank blank none

F blank blank none

G blank blank none

H — blank none

Table F-8  6-Blue 6-Violet 2-UV 4-Red default mirror and filter configuration (continued)

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter
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Special Order Configuration Trigon and Octagon 
Maps

If a slot contains a filter or mirror, a number appears in the corresponding 
position on the configuration map. If a slot contains a blank optical holder, 
nothing is written in the corresponding position on the configuration map.

The default configuration maps are:

• 6-Color Blue Octagon Default Configuration Map on page 181

• 2-Color Violet Trigon Default Configuration Map on page 182

• 6-Color Violet Octagon Default Configuration Map on page 183

• 2-Color UV Trigon Default Configuration Map on page 184

• 3-Color Red Trigon Default Configuration Map on page 185

• 4-Color Red Octagon Default Configuration Map on page 186
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6-Color Blue Octagon Default Configuration Map

57
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488-nm blue laser
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2-Color Violet Trigon Default Configuration Map

450/50

525/50

505 LP

AmCyan

Pacific Blue

405-nm violet laser
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6-Color Violet Octagon Default Configuration Map
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2-Color UV Trigon Default Configuration Map

450/50

530/30

505 LP

Indo-1 (Blue)

Indo-1 (Violet)

355-nm UV laser
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3-Color Red Trigon Default Configuration Map

730/45

710 LP

780/60

755 LP

660/20

APC-Cy7
APC

Alexa Fluor 700

633-nm red laser
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4-Color Red Octagon Default Configuration Map

660/20

APC

730/45

710 LP

780/60

755 LP

685/35

675 LP

APC-Cy7Alexa Fluor 680

Alexa Fluor 700

633-nm red laser
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BD FACS Instrument Configuration Application

This section contains the following information:

• Installing ICA on this page

• Updating Your Default Configuration on page 188

Installing ICA

To install the BD FACS Instrument Configuration Application:

1 Mount your ICA CD on an available drive.

If the installer setup program does not start automatically, launch setup.exe 
from the CD root folder. After the setup runs, the InstallShield Wizard will 
lead you through several installation screens. 

2 On the Setup Type screen, select Complete installation. 

3 When the installation is complete, click Finish and eject the CD.

Re-installing ICA

If ICA is already installed on your computer, the InstallShield Wizard welcome 
screen asks you if you want to modify, repair, or remove the program. To re-
install ICA, first remove it, then rerun the installer.

Uninstalling ICA

To remove ICA from your computer, you can either:

• Run the ICA installer and remove the program as described above.

• Use your operating system’s Add or Remove Programs control panel.
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Updating Your Default Configuration

When you upgrade your BD LSR II instrument configuration, your 
BD FACSDiva software default instrument configuration must be updated.

1 Click Start > Programs > ICA.

The ICA activity window is displayed (Figure F-1 on page 189 shows the 
ICA activity window as it would appear after step 3 below).

2 Choose LSRII from the Select Instrument pull-down menu.

The Select Configuration scroll view lists the available BD LSR II 
instrument configurations.

3 Select the BD LSR II instrument configuration that matches your 
configuration upgrade.

The main text area displays parameter, detector arrays, and channel 
information for the selected configuration (Figure F-1 on page 189).

4 Click Upgrade to update your BD FACSDiva software default instrument 
configuration.

In the main text area, a log shows an update of actions performed on the 
instrument configuration database (Figure F-2 on page 190).
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Figure F-1  ICA: Select Configuration field
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Figure F-2  ICA: upgrade log
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5 Click Save Log to save a file containing the current text of the ICA main 
text view.

A Save As dialog is displayed (Figure F-3). 

6 Choose a location and name for your log file, and click Save.

Figure F-3  Select configuration

7 Click Exit to exit the program.
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Appendix G

Setting Laser Delay

This appendix describes how to optimize laser delay settings in a multiple laser 
system.

• About Laser Delay on page 194

• Optimizing Laser Delay on page 195
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About Laser Delay

Sample interrogation takes place within the cuvette flow cell. Laser light is 
directed through a series of prisms that focus multiple lasers on the event stream 
at different positions. This allows optimal detection of fluorescent signal from 
each laser with minimal cross-contamination from the other beams.

In the BD LSR II four-laser system, the blue laser intercepts the stream first, 
followed by the violet, UV, and red lasers. Because the laser signals are spatially 
separated, there is a slight delay between the detection of each laser’s signal 
(Figure G-1).

Figure G-1  Signal separation over time

The laser delay setting in BD FACSDiva software is used to realign the signals so 
they can be measured and displayed on the same time scale. Signals are aligned 
with respect to the blue laser, so the blue laser will have a 0 delay value, and the 
red laser will have the largest delay.

time

red

blue

UV

violet

event intercepts blue laser

event intercepts violet laser

event intercepts UV laser

event intercepts red laser
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Optimizing Laser Delay

Laser delay is set using BD FACSDiva software. To optimize the delay for a given 
laser, you acquire events from a sample with a fluorescence signal excited by that 
laser. Follow the procedures in Chapter 3, Running Samples, for sample 
optimization and acquiring data.

1 While acquiring data from your sample, create a histogram plot to show 
the fluorescence signal excited by the laser in which the delay is to be 
optimized.

2 In the Acquisition Dashboard, set the Events to Display to 500 evt.

3 Select the Laser tab in the Instrument window (Figure G-2). 

Window extension and laser delay values are displayed in µsec.

Figure G-2  Laser tab of the Instrument window

4 Set the window extension value to 0 µsec.
Appendix G: Setting Laser Delay 195



LSR2.book  Page 196  Tuesday, April 25, 2006  3:34 PM
5 Set an initial laser delay value ONLY for the laser whose delay is to be 
optimized.

• If you are optimizing the violet laser, set its delay to 20 µsec.

• If you are optimizing the UV laser, set its delay to 40 µsec.

• If you are optimizing the red laser, set its delay to 60 µsec.

6 While observing the positive events on the histogram plot, adjust the laser 
delay in 1 µsec increments within a range of 10 µsec of the initial setting. 

Choose the setting that moves the events farthest to the right (highest 
fluorescence intensity).

7 Draw an interval gate on the histogram plot for the positive events. 

8 Create a statistics view to display the mean fluorescence intensity of the 
gated population. 

9 While observing the mean fluorescence intensity for the gated population, 
adjust the laser delay in 0.1 µsec increments within a range of 2.0 µsec of 
the setting obtained in step 6. 

You should also stay within a range of 10 µsec of the initial setting (step 5).

Preserve the setting that maximizes the fluorescence intensity.

10 Reset the window extension to 10 µsec.
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A

acridine orange (AO) 102
adjusting

gate boundaries 61
threshold 60
voltages 60

air in filter, removing 47, 48
alarm, waste container 31
ALPHA filters (AFs) 34
analysis

batch 52
data 66
DNA 78
immunophenotyping 70
reusing 74
saving 74

antibodies 128
applications

calcium flux 90
DNA 78

B

Bal seal, replacing 112
bandpass (BP) filters 34, 131

holder 40
specifications 43

batch analysis 52

battery test 107
Battery Test switch, shown 107
battery, changing 108
BD Calibrite beads 123
BD FACS Instrument Configuration 

Application (ICA) 189
BD FACSClean solution 103
BD FACSDiva software See software
BD FACSFlow solution 123
BD FACSRinse solution 103
BD LSR II

components 26
instrument optics 54
online Help xii
workstation 36

beads, Calibrite 123
beam splitters See dichroic mirrors.
biexponential scaling 52
biohazards xx, 31
blank optical holders 40
bleach solution 103
blue laser 33
buttons

fluid control 28
sample flow rate control 28
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C

calcium flux
about 90
experiment 92
measuring 98
optimization 91
optimizing sample 96
Time parameter 91

calculating compensation 64
calf thymocyte nuclei (CTN)

preparing 79
resolution 86
running 86

Calibrite beads 123
capacity, waste container 31
CEN See chicken erythrocyte nuclei.
changing battery 108
chicken erythrocyte nuclei (CEN)

optimization 80
preparing 79
running 84

Class I laser product xviii
Coherent lasers 33
compensation

calculating 64
controls 60
theory 133
tubes, creating 59
values 53

components
instrument shown 26
optical bench 32

computer system, about 36
configuration maps 158
containers, sheath and waste 31, 44, 47
control panel, instrument 27
controls

compensation 59, 60
single-stained 54, 66

cord, damaged xix
covers, instrument 26
Create Compensation Controls 59
creating

analysis objects 70
compensation tubes 59
global worksheets 66
statistics view 70

CTN See calf thymocyte nuclei.
custom configurations 162
cuvette flow cell 196
CV, troubleshooting 122
Cy-Chrome, filter configuration for 166

D

DAPI
and DNA 79
cleaning after using 102

data
analyzing 66, 70
gating 70
recording 66, 68

calcium flux 98
optimization 88

debris
excessive 122
removing 60

Default global worksheet checkbox 56
delay, laser 196
detectors

photodiode 35
photomultiplier tubes (PMTs) 35
sensitivity 36

dichroic
filters 34
mirrors 34, 133

digital data 26
discriminating filters (DFs) 132
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DNA
experiment criteria 78
flow rate for analysis 126
QC Particles kit 79
using DAPI 79
verifying linearity 78

doublet discrimination 79, 84
droplet containment system 30

troubleshooting 116
DsRed, filter configuration for 165

E

electrical
requirements xiii
safety xix

electronics 136
emission duration 136
environmental requirements xiii
event rate

erratic 120, 121
high 119
low 120
zero 117, 118, 119

excessive debris 122
excitation wavelength 128
experiments

calcium flux 92
DNA linearity 78
immunophenotyping 66
placement in folders 57
sample optimization 57

extra filters and mirrors 162

F

FACSFlow solution 123
Falcon tubes 116

filters
bandpass 34
optical

bandpass 34, 131
changing 42
dichroic 34
discriminating 132
extra 162
longpass 34, 130
shortpass 34, 131
specifications 43
theory 129

sheath, replacing 110, 111
FITC and Stokes shift 128
fixed-alignment lasers 26
flow cell 126

draining 49
flow rate control buttons 28
fluid control buttons 28
fluidics 126

cleaning 102
description 28, 126
flow rate control 28
flushing system 105
priming 49
removing air bubbles 47
run mode 28
sample injection port (SIP) 29, 30

fluorescence 128
emission 136

fluorochromes 133
emission spectra 129
filter configurations and 156, 162
role in light emission 128
which measured 41

forward scatter (FSC) 32, 33, 127
FSC and SSC voltages, adjusting 60
FSC threshold, adjusting 60
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G

gate boundaries, adjusting 61
gating data 70
global worksheets 70

creating 66
previewing data 66, 74

Grid checkbox 62
gridlines, log decade 62

H

handles, instrument 27, 32
hazards

biological xx, 31
electrical xix
laser xvii

Hoechst 102
hydrodynamic focusing 126

I

ICA 167
installing 189
uninstalling 189

immunophenotyping 126
analysis 70
data 67
experiment 66

Include separate unstained control tube/
well checkbox 59

indo-1, filter configuration for 164
instrument

components shown 26
configuration 41, 54
covers and door 26, 42
dimensions xiii
experiment criteria 78
handles 27, 32

setup 53
spares kit 162
symbols and labels xxi

Instrument Configuration Application 
(ICA) 189

intracellular calcium concentration 90

J

JDS Uniphase HeNe 33

K

knob
SAMPLE FINE ADJ 28
sheath clamp 44

L

labels on instrument xxi
laser delay 195
lasers

about 33
classification xviii
power 33
quality control (QC) 49, 152
safety xvii
warming up 38
warmup times 33

linearity, DNA experiments 78
longpass (LP) filters 34, 130
longpass dichroic mirrors

holder 40
specifications 43

LSR II See instrument, BD LSR II.
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M

maintenance
fluidics

daily cleaning 102
flushing system 105

periodic
Bal seal 112
sample tube O-ring 114
sheath filter 110, 111

scheduled
battery change 108
battery test 107
system flush 105
waste management system 107

measuring calcium flux 98
Microsoft Windows operating 

system 36
mirrors

dichroic longpass 34
extra 162
specifications 43

N

NCCLS documents xx
negative population placement 62

O

octagon
description 32
detector 26
location 42
shown 35
template 147

optical bench components 32

optics 54
components 32
cover 32
custom filter configurations

DsRed 165
indo-1 164
PerCP or BD Cy-Chrome 166
PE-Texas Red 163

dichroic mirrors 34, 133
filters 34, 42, 129
location 26
steering 32, 35

optimization 53
calcium flux 91
calcium sample 96
data recording 88
for DNA 78
sample 53

ordering spare parts 152
O-ring, sample tube, replacing 114

P

parameter, Time 91
PerCP

filter configuration for 166
Stokes shift 128

PE-Texas Red 163
photodiode 35
photomultiplier tubes (PMTs) 32, 35
PMT voltages 53
population hierarchy 70
power

requirements xix
switch 26

priming fluidics system 49
propidium iodide (PI)

cleaning after using 102
DNA QC 80
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pulse
definition 136
measurements 137
processors 137

Q

quality control (QC)
about 49
log 141
particles 152
troubleshooting 123

R

Radius laser 33
recording

calcium flux data 98
compensation Tubes 63, 64
data 66, 68
optimization 88

red laser 33
removing air bubbles, filter 47, 48
replacing

Bal seal 112
battery 108
optical filters 42
sample tube O-ring 114
sheath filter 110, 111

requirements specifications xiii
reusing analyses 74
running samples 51

S

safety
biological xx
electrical xix
general xxi
laser xvii
symbols and labels xxi

sample
injection tube 30
optimization 53

experiment 57
single-stained controls 54, 66

tube requirements 116
SAMPLE FINE ADJ knob 28
sample injection port (SIP) 126

cleaning 102
components 29, 30
problems with 116
replacing Bal seal 112
replacing sample tube O-ring 114

samples, running 68
Sapphire laser 33
saving analyses 74
scatter

light 127
parameter distortion 121

setting laser delay 195
setup, instrument 53
sheath

clamp knob 44
container 31, 44
filter, replacing 110, 111
flow 126
fluid 126

backflush 30
pressure 126

shortpass (SP) filters 34, 131
Show Population Hierarchy 70
shutdown, instrument 102
side scatter (SSC) 33, 127
signals, amplifying 35
singlet population, discrimination 84
SIP See sample injection port.
software

adjusting detector voltages 36
instrument control xi
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spares
filters and mirrors 162
kit 162
parts, ordering 152

specifications, filter and mirror 43
specimen

Calcium Flux setup 94
CEN optimization 82

spillover 133
statistics views 70
steering optics 32, 35
Stokes shift 128
switch, Battery Test 107
symbols on instrument xxi

T

technical assistance xv
temperature requirements xiii
testing battery 107
text conventions xi
thiazole orange (TO) 102
threshold

adjusting 60
defined 139
setting 53

Time parameter, calcium flux 91
trigon 36

description 32
detector 26
location 42
template 149

tube support arm 30
tubes

compensation 59
requirements 116

U

ungrounded receptacles xix
Use global instrument settings 57
user preferences 56, 80, 92
UV laser 33

V

violet laser 33
virus protection software xxiii
voltages, PMT, adjusting 60

W

waste container 31, 44
alarm 31
capacity 31
emptying 46

window extension 197
workstation, about 36
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